## Contents

<table>
<thead>
<tr>
<th>Section/Exercise</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>3</td>
</tr>
<tr>
<td>Document Control Sheet</td>
<td>5</td>
</tr>
<tr>
<td>Introduction</td>
<td>7</td>
</tr>
<tr>
<td>What is Activedition?</td>
<td>9</td>
</tr>
<tr>
<td>How Activedition organises content</td>
<td>10</td>
</tr>
<tr>
<td>Templates and Style sheets</td>
<td>11</td>
</tr>
<tr>
<td>Publishing &amp; Workflow</td>
<td>12</td>
</tr>
<tr>
<td>Page Locking</td>
<td>13</td>
</tr>
<tr>
<td>User Roles</td>
<td>14</td>
</tr>
<tr>
<td>Editions</td>
<td>15</td>
</tr>
<tr>
<td>Summary</td>
<td>16</td>
</tr>
<tr>
<td>Section One - Getting Started</td>
<td>18</td>
</tr>
<tr>
<td>Lesson One - Using Activedition for the First Time</td>
<td>19</td>
</tr>
<tr>
<td>Upgrade Process</td>
<td>22</td>
</tr>
<tr>
<td>Lesson Two - The Main Explorer</td>
<td>23</td>
</tr>
<tr>
<td>Exercise: Familiarisation</td>
<td>24</td>
</tr>
<tr>
<td>Section One - Review</td>
<td>25</td>
</tr>
<tr>
<td>Section Two - Building the Site Structure</td>
<td>27</td>
</tr>
<tr>
<td>Lesson Three - Creating Site Areas using Area Manager</td>
<td>28</td>
</tr>
<tr>
<td>Additional Content Management Features in the Area Manager</td>
<td>30</td>
</tr>
<tr>
<td>Exercise: Building the Area Structure</td>
<td>35</td>
</tr>
<tr>
<td>Lesson Four - Creating Pages</td>
<td>36</td>
</tr>
<tr>
<td>Additional Content Management Features in the Page Manager</td>
<td>44</td>
</tr>
<tr>
<td>Exercise: Building the Page Structure</td>
<td>45</td>
</tr>
<tr>
<td>Lesson Five - Creating Multiple Pages</td>
<td>46</td>
</tr>
<tr>
<td>Lesson Six - Copying Pages &amp; Sections</td>
<td>47</td>
</tr>
<tr>
<td>Exercise: Adding Multiple Pages and Copying</td>
<td>49</td>
</tr>
<tr>
<td>Section Two - Review</td>
<td>50</td>
</tr>
<tr>
<td>Section Three - Adding Content</td>
<td>51</td>
</tr>
<tr>
<td>Lesson Seven - Uploading an Office Document</td>
<td>52</td>
</tr>
<tr>
<td>Exercise: Uploading a document</td>
<td>53</td>
</tr>
<tr>
<td>Lesson Eight - Browse and Edit, Page Explorer and Page Editor</td>
<td>54</td>
</tr>
<tr>
<td>Exercise: Edit Textual Content</td>
<td>67</td>
</tr>
<tr>
<td>Lesson Nine - Using Drag and Drop</td>
<td>68</td>
</tr>
<tr>
<td>Exercise: Using Drag &amp; Drop</td>
<td>71</td>
</tr>
<tr>
<td>Lesson Ten - Using the Page Explorer</td>
<td>72</td>
</tr>
<tr>
<td>Exercise: Using the Page Explorer</td>
<td>77</td>
</tr>
<tr>
<td>Lesson Eleven - Adding and Managing Page Comments</td>
<td>78</td>
</tr>
<tr>
<td>Exercise: Adding and Managing Comments</td>
<td>82</td>
</tr>
<tr>
<td>Lesson Eleven - Publishing</td>
<td>83</td>
</tr>
<tr>
<td>Exercise: Publishing</td>
<td>84</td>
</tr>
<tr>
<td>Section Three - Review</td>
<td>87</td>
</tr>
<tr>
<td>Lesson Twelve - Section Libraries</td>
<td>89</td>
</tr>
<tr>
<td>Exercise: Using the Page Explorer</td>
<td>90</td>
</tr>
<tr>
<td>Lesson Thirteen - File Library</td>
<td>91</td>
</tr>
<tr>
<td>Exercise: Using the File Libraries</td>
<td>92</td>
</tr>
<tr>
<td>Lesson Fourteen - Link Library</td>
<td>93</td>
</tr>
<tr>
<td>Exercise: Using the Link Libraries</td>
<td>94</td>
</tr>
<tr>
<td>Lesson Fifteen - Multimedia Library</td>
<td>95</td>
</tr>
<tr>
<td>Exercise: Using Multimedia Libraries</td>
<td>101</td>
</tr>
<tr>
<td>Lesson Sixteen - Newsgroups</td>
<td>102</td>
</tr>
<tr>
<td>Exercise: Using Newsgroups</td>
<td>103</td>
</tr>
</tbody>
</table>
# Document Control Sheet

<table>
<thead>
<tr>
<th>Document Title</th>
<th>4.2(build 1) Content Contributor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author(s)</td>
<td>Steven Forrester</td>
</tr>
<tr>
<td>Document Status</td>
<td>Published</td>
</tr>
</tbody>
</table>

## Document Amendment History

<table>
<thead>
<tr>
<th>Version No.</th>
<th>Date</th>
<th>Page No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Mar 2007</td>
<td>N/A</td>
<td>Published</td>
</tr>
<tr>
<td>1.1</td>
<td>Apr 2007</td>
<td>53</td>
<td>Office Upload can now be used on ‘Office 97’ and above.</td>
</tr>
<tr>
<td>1.2</td>
<td>Jun 2007</td>
<td>78</td>
<td>Adding and Managing Page Comments</td>
</tr>
<tr>
<td>1.3</td>
<td>Oct 2007</td>
<td>95</td>
<td>Copying Image</td>
</tr>
<tr>
<td></td>
<td></td>
<td>96</td>
<td>Image editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>54</td>
<td>Page Explorer bar minimises</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58</td>
<td>Toggle Page Explorer icon removed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>143</td>
<td>Annex B - Hints and Tips added</td>
</tr>
<tr>
<td>1.5</td>
<td>Aug 2008</td>
<td>20</td>
<td>Disable Phishing filter if using IE7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>29</td>
<td>New Area Task Added - Auto Create Menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>82</td>
<td>Hide Comments link added</td>
</tr>
<tr>
<td></td>
<td></td>
<td>110</td>
<td>Expanded information on Hidden fields</td>
</tr>
<tr>
<td>1.6</td>
<td>Sep 2008</td>
<td>30</td>
<td>Sub Area Menu can be added to a Parent Area as a Sub Menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40</td>
<td>Page Menu Options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>44</td>
<td>Email page to users using eMessenger</td>
</tr>
<tr>
<td></td>
<td></td>
<td>101</td>
<td>Newsgroup Categories</td>
</tr>
<tr>
<td></td>
<td></td>
<td>110</td>
<td>Multiple field type available to the Form manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>111</td>
<td>Tiny MCE Editor available to Large Text fields</td>
</tr>
<tr>
<td></td>
<td></td>
<td>111</td>
<td>Upload Settings added to File Upload properties</td>
</tr>
<tr>
<td></td>
<td></td>
<td>126</td>
<td>Query String value can be added to a Menu item</td>
</tr>
<tr>
<td></td>
<td></td>
<td>134</td>
<td>Workflow Status Report</td>
</tr>
<tr>
<td>1.7</td>
<td>June 2009</td>
<td>90</td>
<td>Enhanced library search functionality</td>
</tr>
<tr>
<td></td>
<td></td>
<td>94</td>
<td>Image Profile Overview</td>
</tr>
<tr>
<td></td>
<td></td>
<td>83</td>
<td>Publish Pre check update</td>
</tr>
<tr>
<td>1.8</td>
<td>July 2009</td>
<td>21</td>
<td>Upgrade procedure Build 12 and Above</td>
</tr>
</tbody>
</table>
Introduction

Course Description

The Content Contributors Course covers the core tasks of creating and updating web site content using Activedition. The course will also highlight recent changes to the CMS in line with the current version. This course is particularly aimed at business users within an organisation who are responsible for the creation of content.

Prerequisites

No previous knowledge of Activedition is expected but familiarity with a web browser, a word type editor and an understanding of web concepts such as Links, Pages and Searching is required.

Objectives

On completion of this course the candidate will:

- Have an understanding of Activedition concepts.
- Be able to configure a browser to use with Activedition.
- Be able to edit existing and create new content including placement of text, images, multimedia, links, files and forms.
- Be able to create new Site Areas and Pages.
- Be able to publish updated content to the live site.
- Understand and Manage resource libraries.
- Understand the use of Site Tools and be able to moderate Newsgroups.

Manual Structure

This manual is designed to be used as either a reference tool or training guide. The manual is broken down into sections, each section being broken down into lessons.

- Each lesson begins with learning objectives.
- At the end of each lesson the covered objectives are reviewed followed by an exercise.
- A guide to Windows Keyboard Shortcuts is at Appendix A to this Manual.
- A Hints & Tips section is included at Appendix B to this Manual.
- A Glossary of Terms is at Appendix C to this Manual.

User Feedback

Your feedback is important to us and will help to ensure that this manual remains a quality product. If you have any feedback please contact us at:

C2 Software
Grianan Building
Technology Park
Dundee
DD2 1SW
training@c2software.com
Concepts

Objectives

Before learning how to edit content on the website, it is important to understand the concepts of Activedition and the components it uses to build a site.

In this section you will:

- Learn the fundamental concepts for working with Activedition.
- Understand the components and standard features used to build a site.
- Gain an overall understanding of the product and what elements it uses to deliver content.
What is Activedition?

Web Based Content Management System

A web-based Content Management System (CMS) is a system used to manage the content of a website:

- It allows you to manage web content through the web. Activedition is installed and configured once on a web server. This allows the site to be managed from any location using only a web browser.

- To access Activedition you will require a PC and internet explorer 6+. The website produced by Activedition will support any browser (Netscape, Opera etc.) How the site appears when viewed through these browsers is dependent on the way that the templates are coded.

- The Management application is designed to work effectively with Internet Explorer only.

- No Desktop software to install.

- Full Management of website content:
  - Create the site Structure.
  - Edit and Update Pages and Textual Content.
  - Centrally manage Multimedia, File and Link resources.
  - Use Built in Features to create Forms, Newsgroups, Mailing Lists and other utilities.

- Control Site access, branding and management
  - Control access to secure site areas e.g. ‘Customer’ or ‘Members only’ areas.
  - Specify who can manage different areas and aspects of the site.
  - Use workflow to enforce editorial control over content, only allowing approved content to be saved to the live website.
  - Branding consistency is enforced through the templates and stylesheet.

- Measure Site use and management to inform ongoing site management
  - View detailed web statistics highlighting popular pages and areas, user, referral, click through information and more.
  - View monthly summarized statistics.
  - Use further reports to support site management, review content, and auditing.

Two Applications

Activedition is composed of two applications, the Management Application and the Delivery Application; these are installed as separate applications on the web server, and configured to work together.
• **Management Application**
  This allows you to log in and manage the creation and maintenance of the website, for the purpose of this training we will refer to the Management Application as *Activedition*. A separate URL (web address) will be supplied to access the management application; usually this is similar to the address for the website itself, with either a subfolder (http://www.mysite.com/ae) or a sub domain (http://Activedition.mysite.com) being used.

• **Delivery Application**
  This presents the information edited in the Management application as the website, for the purpose of this training we will refer to this as the *live website*.

**How Activedition organises content**

Content in Activedition is organised using a top down approach and is similar to the way Windows Explorer is organised. As Windows Explorer is organised in Folders and Sub Folders which may contain Files, Activedition uses Areas and Sub Areas which contain Pages of content. Pages are made up of sections which can contain textual content and links to Library Sections such as the Multimedia Library which may have uploaded images or sound files.

![Diagram showing the structure of Activedition's content organisation]

**Definitions:**

- **Site**: This is a container for Site Areas, when logged into Activedition you can only manage one Site.

- **Site Areas**: These can contain other Areas called Sub Areas, allowing hierarchical structures to be built similar to Directories on a PC. Site Areas can also contain Pages.

- **Pages**: Pages are containers for Sections of editable content. Templates and Style sheets are applied to pages and define the look and feel of the content on that page and where it appears.
- **Sections**: Can contain textual content or items placed from the various resource libraries such as the Multimedia, link and Tag libraries. Where Sections appear on a page is determined by the template.

- **Libraries**: These are repositories that hold resources such as multimedia or forms.

- **Section Library**: Allows sections to be managed on a per library basis, any changes made to a section held in the section library will affect all placements of that section throughout the site once published.

### Templates and Style sheets

Activedition templates are constructed in standard HTML or XHTML like any other webpage, with specialist Activedition tags embedded in the code to control the location of content and other items on the page. Once templates are complete Administrators can upload the template into the system and they can be applied to pages. Stylesheets are created using CSS, and also need to be uploaded into Activedition before they can be applied to pages in the site.

**Templates Define:**

- The branding of the site.
- The layout of editable sections on a page.
- Where menus or other navigation appears.
- Where other items defined in a pages properties appear. This gives control to such items as the title seen in the blue bar at the top of the browser, meta elements in the source code used by search engines and page headings.
- The location of additional elements such as embedded login/password, search etc.
Style sheets Define:
- Custom elements used in template design.
- Textual styles such as headings and links. When editing textual content the editor is restricted to the styles that are defined in the stylesheet chosen for the page that the Section is a part of, there is no option to choose other fonts, sizes and colours used, substantially enforcing brand consistency across the site.

Publishing & Workflow

Activedition publishes content; meaning that once editing is complete pages can be made available on the live website. When this happens, the pages are created as files on the web server. It is possible to publish individual Pages, Site Areas or even the whole Site.

- Pages can be edited in draft mode, in this mode the changes are visible in Activedition but not in the live website. Once the changes made are agreed the page can be published to make it visible on the live website.

- In Activedition users can be Authorised to edit/delete content in particular Site Areas, in a similar way it is possible to assign Users the ability to publish (or not) Content in particular Areas.

- Enabling “Workflow” in the system options will add another Status for pages. As well as “draft” and “published” there will also be an “awaiting publishing” status. In this case pages must be submitted for publishing prior to being published. This allows specific users to have editorial control over the content that is set live on the website.

- Notification lists ensure that the appropriate users are informed via email or the task manager in Activedition when a change has been made that requires their attention.

Publishing applies to elements in the resource libraries in a similar way to Pages. If a link or image used in the site is updated it will need to be published to make it available to the live website. The option to publish library items is available in the appropriate library, although library items will automatically be published when a Page that contains a Section with the item placed on it is published. There is no “Awaiting Publishing” status on library items when Workflow is activated.
Page Locking

- **Page checked out to another user**

- **Page Locked**

- **Page checked out to currently logged in user**

Page locking is an optional feature that can be enabled through the System Options by an Administrator.

Enabling this feature ensures that pages cannot be edited by more than one Activedition user at any given time. If Page Locking is not enabled then multiple users could potentially edit the same page at the same time. In this scenario whoever saves last will update the content, although if version history is enabled the version saved by each user would be available.

If Page Locking is enabled then only one user may edit a page at any given time. The state of the page, indicating whether it can be edited or not will be indicated by one of the icons above:

- The grey padlock icon indicates that the page is **checked out** to another user and can’t be edited. Administrators have the ability to **check in** pages that other users have **checked out**.

- The dark padlock icon indicates the page is **locked**. In this state it needs to be checked out before it becomes editable.

- The red tick icon indicates that the page is **checked out** to the current user. In this state the page is editable by the currently logged on user.
User Roles

The differing User Roles determine what options a user has for accessing secure areas of the website or Activedition, and the scope of any site management features available.

Administrator

The Administrator role offers automatic access to any secure areas of the site, and full access to all of the management facilities available in Activedition. Administrators have the ability to edit, delete and publish content in all Site Areas, are able to manage items in any Library, can manage Users, Mailing lists and all other features.

It is also possible to tailor administrative roles on a per Administrator basis, customising which management features are available to a particular Administrator. It is not possible to restrict the scope of any specific management feature, e.g. if an Administrator has area management enabled they will have access to all areas.

Sub Administrator

The Sub-Administrator role provides a level of permissions control between the current Administrator and Content Contributor roles. Unlike the Administrator role the Sub-Administrator does not have automatic access to any secure areas of the site neither do they have full access to all of the management facilities. As per the Administrator it is possible to tailor Sub Administrative roles on a per Administrator basis. Managers such as Code, Content Types, Email Mailing List and Language are unavailable to the Sub Administrator. Most reports are unavailable except for the Page Statistics, Area Statistics, Content Review and Workflow Status reports. There is no access to configuration.

This role is intended for those who are responsible for the administration of specific areas within the site. They are able to create Sub-Administrators, Content Contributors, Site Users and assign permissions, but may be restricted by the Site Administrator on what Areas, Libraries or Administrator tools they have access too.

Content Contributor

The Content Contributor has access to a limited number of management tools in Activedition; by default the minimum authorisations for these are set, allowing Administrators to assign them management facilities on a site restricted basis as appropriate. Content Contributors do not have automatic access to secure areas of the live website and must have it specifically granted.

This role is intended for those updating and creating content only, as such only content related facilities are available with no access to administration, configuration or most of the reporting features.

Site User

A Site User cannot access Activedition to manage content. This role is intended for clients accessing secure areas of the website such as a member’s area. The secure areas that Site Users can access must be specifically set by an Administrator.
Editions

Professional Edition
The professional edition allows the management of the web site or intranet to be dispersed amongst chosen personnel. Limited to 4 Administrators with a stepped licensing model the system is designed to grow with the organisation. You only pay for what you need.

Optional Modules
- Geographical Statistics (requires annual license for IP2Location database)
- LDAP (Lightweight Directory Access Protocol)
- PDF Publishing
- Activedition Metadata System
- Configurable Workflow
- Content Import & Export Engine

Enterprise Edition
Designed for the medium to large organisation the Enterprise Edition is sold on a per server basis. An organisation can create as many web sites as desired and can empower personnel as and when required. The Enterprise Edition also includes the Meta Data module and unlimited Administrators as standard.

The Enterprise Edition is licensed for a specific organisation and sub-licensing is not permitted without express permission.

Optional Modules
- Geographical Statistics (requires annual license for IP2Location database)
- LDAP (Lightweight Directory Access Protocol)
- PDF Publishing
- Configurable Workflow
- Content Import & Export Engine

Notes
Summary

In this section you learnt:

1. That Activedition is a Web based content management system

2. It has two applications:
   a. Management Application (Activedition)
   b. Delivery application (live website)

3. That Activedition organises site content into areas, each area contains a page or pages. Pages are made up of sections which can contain textual content. Sections could also have links to libraries such as the Form or Multimedia libraries.

4. That Activedition uses pre-defined Templates and Styles

5. Publishing allows pages to be available on the live website. Site areas and pages have two modes Published (P) or Draft (D), if workflow is enable a third mode is available Awaiting Publishing (A)

6. If page locking is enabled a page cannot be edited by more than one Activedition user at any given time

7. There are four user roles:
   a. Administrator
   b. Sub Administrator
   c. Content Contributor
   d. Site User

8. There are Two Activedition editions:
   a. Professional
   b. Enterprise
Section One - Getting Started

Aims and Learning Objectives

This section will familiarise you with the actions required to use Activedition for the first time. The Logging in screen will be explained and the Main Explorer Interface will be described in detail. After this section you will have learned the following:

- The tasks required to start using the application for the first time.
  - Creating a bookmark
  - Preparing the Client PC

- How to set up a system the first time it's used with Activedition.
  - Logging in
  - The login interface

- Using the main explorer interface.
  - Management Groups
  - Toolbar
  - Task Manager
Lesson One - Using Activedition for the First Time

Creating a Bookmark

Most people will bookmark Activedition for ease of future access, to prevent possible problems it is important to edit the bookmark so that it uses the web address supplied for accessing the management application, e.g. http://www.mysite.com/ae, rather than the one that you are redirected to so that you can log in, e.g. http://www.mysite.com/Activedition/aelogin.asp.

- Visit Activedition on the web address supplied for managing your site.
- Add to Favourites in the normal way (Favourites->Add To Favourites.)
- Choose Organise Favourites from the favourites menu and locate the Activedition bookmark just added.
- Right click the link and choose properties.
- Edit the URL: entry so that it is the same as the one supplied, rather than nms/netman.asp address redirected to.

Preparing the client PC

While there is no requirement to install any desktop software to use Activedition, there is one optional browser control (activeX controls) that should be installed before you can use the Multiple File Upload control, and another if the Configurable Workflow module has been activated.

You will need to be logged on to the PC as an Administrator to install these controls, once installed a non administrative account can be used to access and use Activedition. If you need your IT department to install these controls on your behalf, details of the controls to be installed can be provided by your Activedition reseller on request.

The installation (browser setup) is completed as follows: THIS MUST BE DONE BEFORE USING THE CMS

- Visit Activedition
  - In the Browser toolbar left mouse click onto Tools then hover mouse over Pop-up Blocker, select Turn Off Pop-up Blocker.
- If you are using IE7/8 we recommend disabling the Phishing filter from the tools menu by hovering mouse over Phishing Filter the select Phishing Filter settings. In the settings window scroll down to the bottom of the window and Disable Phishing Filter.
- Select the Browser Setup link under the login boxes. A new ActiveX Installation window will open, click “Yes” on the popup dialogues that appear to download and install the controls.
- Once installed you will see the controls listed in the window, to ensure they are correctly installed complete the following tests.
  - Configurable Workflow Control: Allows the user to test that all the controls within Configurable Workflow are working correctly.
  - Multiple File Upload tool: Clicking onto the Add Button which will open Windows File Manager allowing the user to test whether more than one file can be uploaded into this tool.

Should you encounter an error message, or not be able to complete any of the tests; details of common errors and their solutions can be found in the knowledgebase www.support.activedition.com/kb or call support on 0870 705 0002.
If you see an⚠️icon on the bottom left of the window, double clicking it may give details of any error. If you are unable to complete the Browser Setup please contact your Activedition reseller for further assistance.
Logging On

The Login screen in Activedition will be displayed as shown:

Once the licence agreement has been read you can login with the credentials supplied by an Administrator.

The following options are available:

- **Forgotten Password?**
  Your password can only be retrieved if you have a valid email address stored against your user id in the Activedition User Manager.

- **Licence Agreement**
  All users should read this prior to using Activedition

- **Browser Compatibility**
  This is a link to download the latest version of Microsoft Internet Explorer.

- **Browser Setup:**
  Installs the optional activeX controls required by Activedition

- **System Activation**
  If System Administrators need to update the activation key for the system due to an upgrade, purchase of further management modules or annual key renewal they can do so here.

**Concurrent Users**

Only one user can be logged in using a particular User ID at any time, if you try and log in and another user is currently logged in to Activedition using the same credentials you will be informed of the date / time of the login and given the option of trying to log in with alternate credentials or logging the other user off. Note that if you choose to log someone else off this will be recorded in the administrative reports.
Upgrade Process

For Activedition 4.1 (Build 12) onwards a user may be required to upgrade the product from a prior version. If so the user will be informed of this within the management login screen and a link will be presented that will invoke the upgrade process. Users will be unable to log into Activedition until the upgrade has been completed.

Users should click on the link and follow the onscreen instructions to complete the upgrade.
Lesson Two - The Main Explorer

After logging on you are redirected to the main Explorer, this is the “Home Page” of Activedition, from here you can access all the content editing and management features, the view that you see here may vary depending on the permissions and role settings assigned by a site Administrator.

Management Groups
The left hand pane displays all the management modules and utilities available to the currently logged in user, all managers and utilities are launched with a left mouse click, these are split into five Groups:

- **Site Management**
  Managers in this group are used for building site structure and editing/copying content; this is the main grouping used in day to day maintenance of the site and creation of new areas, pages and content.

- **Libraries**
  Managers in this group are used for centrally controlling items in the Resource Libraries. Content Contributors will only see a subset of the available libraries.

- **Administration**
  This group is used to control System Configuration, User Management and other administrative functions. This grouping is not available to Content Contributors.

- **Reports**
  Comprehensive Site Statistics and Activedition management reports are available in this group. Only the Workflow Status report is available to Content Contributors.

- **System**
  This group enables Administrators only to either update the Activation key, check what Modules have been enabled or amend System Options. This grouping is not available to Content Contributors.

The required group is displayed by clicking onto the respective down arrow on the right hand side of the group or the blue title bar.

Toolbar
The toolbar offers shortcuts to access the managers and utilities that the logged on user has authorisations to use. The options for the manager selected will be displayed as links below the toolbar and remains static until another manager is selected thus saving the necessity of returning to the Main Explorer. In the case of the following image, Systems have been selected.

Additional toolbar items are as follows

- **Window Management**
  The dropdown list next to Find Page allows navigation to Main Window leaving all other open windows minimised or closing all windows.

- **Find Page**
  Selecting this option will launch the Find Page dialogue box which will enable pages to be searched by Page Name, Heading, Title, Number or Section Name. Once the page has been located you will either be able to edit the properties of the
Logout

Ends the current user session in Activedition.

Refresh

This will reload the whole window, similar to pressing F5 or clicking the refresh button in the browser.

At the base of the screen the following link and information is available:

Live website link
This is the text on the bottom left hand corner of the screen, clicking this will open the published website in a new window. This allows you to compare the draft and live websites. The text of the link is the name of the Activedition Project. Administrators are able to change this value in System Options.

Logged in User
The ID of the currently logged on user is displayed immediately to the right of the live website link, this is followed by the user role of the logged in user.

Automatic Log Off
This will display how long you have before Activedition automatically logs off, prior to log off a message will be displayed inviting you to continue.

Task Manager
This is a simple note taking facility that appears by default in the right hand pane of any window that opens in Activedition, and offers the following features:

- Tasks can be created / edited / deleted.
- Single or multiple tasks can be marked as Complete / Deleted.
- Tasks can be assigned to Content Contributors by Administrators.

The Task Manager is also used for some system messages, such as informing that the whole site requires publishing after an upgrade, or to notify members of a Notification List when a page has been moved to draft / submitted for publishing / published.

Help
Context Sensitive Help is available throughout Activedition and can be accessed by clicking onto the question mark icon on the top right hand corner of any displayed screen.

In most cases help will consist of the subject, concepts and processes.

Exercise: Familiarisation

1. Familiarise yourself with the Main Explorer Managers and Toolbar options
2. Add the following task to the Task Manager: “Create my own Home Page”
Section One - Review

Lesson Summary

In this section you learnt:

1. How to upgrade Activedition if appropriate.

2. The tasks required to start using the application for the first time by creating a Bookmark and preparing the client PC.

3. How to setup the system ready for use with Activedition by using the options and links available in the Logging in Interface.

4. That the Main Explorer interface has the following components:
   a. Management Groups
      - Site Management
      - Libraries
      - Administration (Admin only)
      - Reports
      - System (Admin only)
   b. Toolbar
      - Shortcuts to authorised Managers and Utilities
      - Live Website link
      - Logged in User
      - Refresh
      - Window Management
      - Log Off

5. The Task Manager can be used as a simple note taking facility, it is also used for some simple system messages such as publishing notification and has the following additional functionality:
   - Tasks can be created/edited/deleted
   - Single or multiple tasks can be marked as Complete/Deleted
   - Tasks can be assigned to Activedition users by Administrators.
Section Two - Building the Site Structure

Aims and Learning Objectives

This section will introduce the Site Management Interface. Here you will learn how to use the Area Manager to create and maintain Areas and the Page Manager to create and maintain Pages. You will be given a number of scenarios to complete to practice building the Site Structure. After this section you will have learned the following:

- How Area Manager is used to manage different site areas and pages.
- How to create, edit, manage site areas and create secure site areas.
- How to create single and multiple pages, copying pages and sections.
Lesson Three - Creating Site Areas using Area Manager

Site Area creation and Management is controlled through the Area Manager. This displays the site structure as folders in a tree view on the left hand pane.

To create a new Site Area right click onto the Area Manager name at the top of the tree view and choose the Add Area option. To create a sub area of an existing Site Area, right click the Site Area name in the tree view and choose the Add -> Sub Area option. The Add New Area Form will appear in the right hand pane:

Add New Area Form

The Add New Area form is broken down into the following four Tabs:

- General
- Availability
- Menu
- Advanced

General

The General Tab displays the fields required to create an Area, once the fields are completed click onto the Save button to make the Area available in the Area Manager.

The following fields are available:

- **Title**
  The Title is the Area Name that will appear in the Site Area tree view in the left hand pane; this is used in the breadcrumb trail. Spellchecking is available for this field by clicking the button. The Title must be unique site wide.

- **Published Name**
  This is the name of the Site Area as it appears in the URL (as appears in the address bar) for the live website. This allows you to have a descriptive Area Title and restrict the length of the URL.

  **Note:** The Published Name must be unique within the parent area. For example Areas named Home/my_area and Careers/my_area are permissible, but two sub areas called my_area in the same parent area is not and a warning message will be
displayed.

- **Allow User Selection**
  This option leaves the template and stylesheet fields free allowing the user to select required templates or styles from available libraries.

- **Specific Values for Stylesheet & Template**
  Sets the template and stylesheet that will be selected by default in an areas properties when it is being created. If the Fixed option is set to yes then pages created in this Area will only be able to use the Default Page Template when they are created. If no is selected any available template can be used. This enforces area specific templates / branding.

- **Allow Selection via Library**
  This option specifies what Library is available for use on the site; options are available to select default Stylesheet and Template.
  **Note:** There is no template fixing option.

### Availability

The Availability Tab is used to determine the visibility of the area.

The following option is available:

- **Site Map**
  A dynamic site map is included with Activedition (see the Site Tools section,) this entry determines whether this area will appear on the Site Map.

  **Note:** The default visibility is set to Yes

### Menu

The Menu Tab is used to add the area to the Menu Manager as a standalone menu group or a sub menu group of an existing menu group. When set any new pages will automatically add themselves to the area menu group.
The following options are available:

- **Menu Details**
  - **None**
    - Selecting this option will take the created area menu group out of the menu manager.
  - **Use existing**
    - Selecting this option will enable you to add this area as a Sub Menu in an existing Menu.
  - **Create new**
    - Selecting this option will enable you to create and name a new menu group which will be accessible from the Menu Manager. If required this menu can be placed in an available Library

- **Add Pages to Menu**
  - Selecting yes will enable any new pages to be added into the area menu group automatically.

- **Add to Parent Menu**
  - Selecting yes will add the Sub Area as a Sub Menu to the Parent Area menu group.

**Menu Item Details**

<table>
<thead>
<tr>
<th>Add to Parent Menu</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Menu</td>
<td>[Default Library]/Home</td>
<td>Select</td>
</tr>
<tr>
<td>Title</td>
<td>About Us</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>10</td>
<td>Record View Parent Menu Items</td>
</tr>
</tbody>
</table>

**Advanced**

The Advanced Tab is used to change Settings and set Authorisation for the Area.
The following options are available:

- **Parent Area**
  If you are creating a sub area you will see the Parent Area selected here. Should you wish to move the Area to another part of the site you can do so by choosing the appropriate Area from the list.

  **Note:** That there is no need to publish the Area once moved.

- **Language**
  This determines the default character set used for pages created in this Area i.e. selecting Chinese would allow Chinese Characters to be used on a Page in this area. It is recommended that unless a particular character set is required no language is selected.

- **SSL Encryption**
  If this option is selected the pages in this Area will be served over a secure connection, for this to work a Security certificate must be installed on the server. This is usually used when credit card details or particularly private information is posted in forms on the pages in this area.

- **Workflow**
  If Configurable Workflow is enabled this option will be available and allows you to select a pre-defined workflow for the required Area.

- **Password Protected**
  This determines whether a Site User has to log in with an Activedition UserID and password to view the pages in this area. Only Administrators can set authorisations on who has access to the area. Users can only be added to the system by an Administrator or custom registration script. Secure areas are identified in the Site Areas tree view by a small key on the Area Icon.

  **Note:** This applies to new Sub Areas only.

- **Cascade Permissions (Administrators only)**
  This determines whether or not new Sub Areas created within this site area will inherit authorisations and security settings. If the authorisations on the area being edited are changed the Tasks -> Cascade Security Menu option for the area should be used to force all existing sub areas to inherit the new authorisations.

  **Note:** This applies to new Sub Areas only.

- **Cascade Area Properties**
  This determines whether or not new Sub Areas created within this site area will inherit area properties set at parent level.

**Meta Data**

If Meta Data has been assigned to areas you can edit Meta Data by choosing any sub metatype from the list and ticking the box. It may be that you are forced to edit the Meta Data when you add or edit an Area.
If you choose to edit Meta data a form predefined by an Administrator will be displayed that you can complete as necessary. Meta Data requirements will vary on a site by site basis; if you have any questions contact an Administrator.

Once the area has been created these settings can be changed by clicking the Site Area in the tree view and choosing the properties option.

Notes


Additional Content Management Features in the Area Manager

Other additional features in the Area Manager are as follows:

- **Apply template**
  Clicking onto Tasks/Apply Template will allow you to apply a particular template to the Site Area or even the whole site if you are an Administrator, and is also available in the Page Manager. Applying a template will override any Fixed Template settings at Area Level.

- **Page Locking**
  If Page Checkin/Checkout has been enabled in System Options all pages can be checked in or out at either Sub Area, Site Area level or across the whole site.

- **Publish Entire Site**
  Available from the root node of the Area Manager. Allows users with appropriate permissions to publish the whole site, if workflow is enabled all pages in the site must have a status of Awaiting Publishing for this to work.

- **Office Upload**
  The Add/Office Upload option allows either a Microsoft Word or Excel document to be uploaded as a page within the required Area. Any External links and Multimedia associated with that document will be uploaded into the respective Libraries.

To upload an Office Document select the required Area, Hover mouse over Add and select Office Upload.

- **Delete Multiple Pages**
  To delete multiple pages select required Area, Hover mouse over Delete and select Multiple Pages.
Either select all pages by selecting the All link or select individually by selecting the required checkbox. Clicking onto the None link will clear the selection.

**Note:** All Sections within the pages will also be deleted. If you wish to keep the sections then you must move them to another page first. Site deletions will update the live site immediately without requiring that a publish take place.

- **User Authorisations (Administrators only)**
  Administrators can authorise a Content Contributor or Site member to either Read, Delete, Update or Publish an Area. Click onto the required Area, hover mouse over Tasks then select User Authorisations.

  The current users authorised for delete access on this area are shown below:

  There are currently no users authorised for this area

  ![Add Button](Add)

  The current users authorised for update access on this area are shown below:

  ![Finlay Carmichael](finlayc2 (Finlay Carmichael))

  ![Add Button](Add)  ![Remove Button](Remove)

  Clicking onto the Add button will take you to the Add Additional Users screen where required users can be selected from. Clicking onto the Remove button will take you to the Remove Users screen.

- **Cascade Security (Administrators only)**
  This will force all existing Sub Areas to inherit new authorisations. Click onto Required Area and hover mouse over Tasks, select Cascade Security then select the Yes button to make the changes.
• **Auto Create Menu**
  This option will enable the user to create a new menu for the required area or add the area to an existing menu; also existing pages can be automatically added to an existing or newly created menu.

**Exercise: Building the Area Structure**

1. Create an area *myname_home*
   a. Choose a Default Template

2. Create a sub-area *myname_members*
   a. Make it a secure area
   b. Choose a default template
   c. Make this a fixed template
   d. Ensure that this area is not on the Site Map

3. Create a new menu group for the *myname_home* area and set the *Add Pages to Menu* option to Yes.

4. Add the *myname_members* area to the *myname_home* menu by using the *Use existing* option.

**Notes**
Lesson Four - Creating Pages

Page management is controlled through the Page Manager. This will list all the pages in a particular area, displaying summary details, publishing status, and allowing you to edit and perform other actions on the pages. To view the pages for a particular area left click the Area name or right click the select the Manage Pages option, the Page Manager will open in the right hand pane.

You can search for a particular page by clicking onto the button adjacent to the Filters title; this will display a search box, clicking onto the filter button again will hide the search field. Clicking onto the column link name will sort the respective column in either descending or ascending order. Hovering the mouse over the icons on the right of the column heading will display a description for that column.

There are three methods that can be used to create a new page you can either:

- In the Site Areas tree view right click the Area you want to create the page in and choose the Add -> Page option from the menu.
- In the page manager right click the Area name Adjacent to the Page manager Title and choose the Add -> Page option from the menu.
- In the Site Management Group click onto the Add Page icon.

In either case the New Page form will appear in the right hand pane.
Add New Page Form

The Add New Page form is broken down into the following Six Tabs:

- General
- Availability
- Menu
- Publishing
- Advanced
- Meta Data

General

The General Tab displays the fields required to create a Page, once the fields are completed click onto the Save button to make the Page available in the Page Manager.

- **Name**
  The page name is used as the name for the file that is published to the live website, e.g. a page called ‘contact’ in the home area would be published to http://www.mysite.com/web/site/home/contact.asp. The name will also be used in the listing in the Page Manager and elsewhere in Activedition. The page name must not contain spaces. The page name must be unique site wide.

  **Note:** Changing this option will update the live site immediately without requiring that a publish take place.

- **Title**
  This is used on the title seen in the blue bar at the top of the browser, a title of Contact Us would appear as follows:
The title is also used as the default text for the link to this page that is added to the link library when the page is created. Spellchecking is available for this field by clicking the ABC button.

- **Create a link in Link Library**
  If a link is not created in the link library it won’t be possible to access the page created from other parts of the site. This option is sometimes used for newsletters that are only needed to be accessible via email or the exact URL.

- **Heading**
  The heading text entered here may or may not be used as part of a template that is applied to the page. This is controlled by how the template has been designed. Spellchecking is available for this field by clicking the ABC button.

- **Area**
  Similar to the Parent Area field in the Area Properties, this indicates the Area that the page belongs to, to move the page to another Site Area, choose the appropriate area from the list.

  **Note:** Changing this option will update the live site immediately without requiring that a publish take place.

- **Description**
  This also corresponds to Meta information in web pages, and will be the descriptive text for a page returned by the site search included with Activedition. It is important that all pages have an appropriate description entered in the page properties, if they don’t then text from the top of the page (usually template links) will be displayed as the description for that page in the site search results. Spellchecking is available for this field by clicking the ABC button.

- **Keywords**
  Keywords added correspond to the Meta Keywords used in the source of web pages to describe the content to search engines; these are also used by the Activedition site search. The keywords should be separated by either commas or spaces.

- **Style Sheet**
  Allows the stylesheet set at Area level to be overridden.

- **Template**
  allows the template set at Area level to be overridden unless a fixed template is used.

  **Note:** The templates are ordered by library in the droplist that the user is authorised to use.

- **Preview**
  Preview offers you the ability to see the combination of stylesheet and template with some sample content, sample page heading etc. Click the appropriate button for the screen size you want to see the preview in.
Availability

The Availability Tab is used to determine the _Validity_ and _Visibility_ of the page. There is also a _What’s New_ section which will allow a Headline to be inserted along with a display until date.

- **Display From**
  This sets the date from which the content in the page created is visible on the live website, when the page is not valid the site user visiting it sees a message informing them of when the page content will be available. If this date is left blank the page will become available to site users viewing the live website as soon as it is published. E.g. if a page is set to be valid from the 14th it can’t be viewed on the 13th but can be on the 14th.

- **Display To**
  This sets the date when the content in the page created is no longer available on the live website, when the page is no longer valid the site user visiting it will see a message informing them that the page content has expired. Leaving this value blank means the page never expires. E.g. if a page is set to be valid to the 14th it can be viewed on the 14th but can’t be on the 15th.
- Site Map
  If an area IS on the site map the PAGE settings override the AREA settings, otherwise this setting can't be changed.

- Site Search
  You may not wish certain pages, such as thank you pages seen after submitting a form, to be included in site search results.

  **Note:** Changing this option will update the live site immediately without requiring that a publish take place.

- What’s New
  There is a page included in Activedition that will display links to all the pages with current What’s New Headlines:

  - **Display Until**
    This is the date that the headline will appear on the what’s new page until. This may be automatically set dependant on how Activedition is configured. E.g. If a page has a headline expiry date of the 14th set, the headline will be visible on the 14th but not on the 15th.

  - **Headline**
    This is the text of the link to this page that will appear on the What’s New Page. Spellchecking is available for this field by clicking the button.

**Menu**

The Menu Tab is used to add the page as a link to the Areas Menu group if set, this will automatically be actioned if Add Pages to Menu has been set in the Menu tab at Area level.

![Add New Page](image)

When Add to Menu has been changed to Yes the following options are available:

- **Menu Item Details**

  - **Menu**
    This is the parent menu name and already populated.

  - **Title**
    This field is populated with the Page published name but can be changed.
- Order
  The order that the link is to be displayed within the menu group. Selecting the Reorder/View Menu Items link will display all linked items with the option to reorder them.

- Default menu link
  If selected this page will be the landing page when the parent menu group is selected.

- Context synchronise this menu item with this area
  If selected the page will be synchronised with the parent menu which will keep the menu visible when the page is selected from the menu group.

---

**Publishing**

This tab has a number of options that affect the page when publishing.

- **Workflow**
  If Configurable Workflow is enabled; this option enables a pre-defined workflow to be selected against the required page.
• **Publish**  
The Publish On Field allows the User to declare a future date for the publish of this page (assuming it is in the correct state prior to the publish date) additionally a publish time can also be declared in a 24 hour format.

**Advanced**  
This Tab allows optional page settings to be added or amended.

- **Area Home Page**  
This setting specifies the page that will be returned if you type the URL for the site area only. There can only be one default page per site area, the default page can be changed at any time.

  **Note:** The page will have to be published before this comes into effect. The Default Area Page is indicated by a (*) in the Page Manager.

- **Review Date**  
This sets the date when the content in this page is due for review, the review dates for the page can be set directly or chosen from a months drop down list. After publishing the review date is calculated based on what has been chosen.

- **Record Statistics**  
This sets whether page hits are recorded for this page. The default value can be set by an Administrator. Full Statistics Reports are available to Administrators only.

- **Language**  
This allows the language set at Area level to be overridden.

- **Custom ASP**  
This is used when integrating custom scripts in the site and should never be changed by Content Contributors. Changing this option to No on an existing custom page will break the custom functionality provided by the page.

- **SSL Encryption (Secure Socket Layer)**  
This allows the SSL option set at Area level to be overridden.
Note: Changing this option will update the live site immediately without requiring that a publish take place.

Meta Data

If Meta Data fields are associated with pages you have the opportunity to edit them here.

- **Type**
  This allows you to change the Meta Data Type set against the required page.

- **Edit on Save**
  Clicking on this checkbox enables you to edit the Meta Form associated with the Meta Type selected.

Once saved the page properties can be edited by left clicking the page in the Page Manager and choosing the Properties option.

When in edit mode there is an additional update links option on the page title, if you tick this box all placed links on the site will be updated to use the new title text for the page once those pages are re-published. However, if a link to the amended page is using an alternative description then that link will not be updated with the new title text.
Additional Content Management Features in the Page Manager

Other additional features in the Page Manager are as follows:

- **View ->**
  This allows the Browse and edit version of the page to be viewed in different browser sizes.

- **View -> Advanced**
  The advanced option allows you to view the site as it would appear on a particular date.

- **View -> Live-Draft Comparison**
  This option will only appear if a change has been made to a published page and will display both the draft (right hand pane) and published page (left hand pane). User has options to Submit for publishing or Submit for Publishing with comments.

- **View -> Published Page**
  This option allows you to view the page that is currently published.

- **View -> History**
  This option allows the viewing Page History. Every time a page is published a version of that page is created.

- **View -> Comments**
  This option allows the user to view comments placed on a page using the View Comments tag. A detailed explanation of Comments can be found at Section Three Lesson Eleven.

- **Copy -> Sections**
  Copies Sections, placements and contents from one page to another.

- **Tasks -> Delete Page**
  Deletes the required page.

  **Note:** All sections within the page will also be deleted; if you wish to keep the sections then you must move them to another page first. Site deletions will update the live site immediately without requiring that a publish take place.

- **Tasks -> Email Page To User**
  Emails the published version of a page to an Activedition user, group or mailing list.

- **Tasks -> Email Page To User (eMessenger)**
  This option will only appear if you have signed up to eMessenger and will Email the published version of a page via eMessenger to an Activedition user, group or mailing list. Unlike the Email Page to User mentioned above, a date and time can be scheduled for the delivery of the email. (See Hints and Tips at Appendix B of this manual for more information).

- **Tasks -> Statistics**
  Details the page hits by date for the specified page for all time.
Exercise: Building the Page Structure

1. In the myname_home area create a page myname_home
   a. Change the Template
   b. Set for review in 2 days time
   c. Set the What’s New Headline
   d. Set as the Area Home Page
Lesson Five - Creating Multiple Pages

As well as being able to add single pages there is the option to add several pages at once, this can be particularly useful if you are creating a new area of the site and want to quickly build up the structure. However if you want to make one of the pages the area home page or change the style then you will have to update the properties of that page.

To add multiple pages:

- Right click the area you want to add the pages into, either in the Area Manager or in the Page Manager.
- Choose the Add -> Pages option.
- Enter the number of pages that you want to create and click the Next >> button.
- Select whether you want the pages to appear in the group area menu.
- Complete the summary details for each of the pages that you want to add and save.

The pages will now be visible in the Page Manager; you can further edit the pages details by left clicking the page and choosing properties.
Lesson Six - Copying Pages & Sections

Sometimes it is useful to copy existing pages or sections prior to editing, this can be for a number of reasons; it could be that you want an exact copy of the layout of section content, or that you want to translate the page into a different language.

To copy a page:

- Open the Area Manager and choose the Manage Pages option on the Area that contains the page you want to copy.
- In the Page Manager click on the page you want to copy and choose the Copy -> Page option
- Choose the Area that you want to copy the page to from the list, and enter a name for the copied page

Once complete you will be taken to the Page Manager for the area that you have copied the page to, from here you can continue to edit the details and content of the new page.

To copy a section

- In the Page Manager click on to the page whose section you want to copy and choose the Copy -> Section option.
- Choose the Destination Area that you want to copy the Section to from the list, then choose a destination page.
- Either choose the Copy All option or select which section you wish to copy from the displayed list.
Once complete you will be taken to the Page Editor for the page that you have copied the section(s) to, from here you can continue to edit the details and content of the section(s).

Notes
Exercise: Adding Multiple Pages and Copying

1. Use the Add->Pages option to create 2 pages with name and heading as follows:
   a. myname_thankyou
   b. myname_contact

2. Edit myname_thankyou page so that the page is not on the site map

3. In the myname_home area copy the myname_home page to the myname_members area changing the heading, title and what’s new date as appropriate.

Notes
Section Two - Review

Lesson Summary

In this section you learnt:

1. How the Area Manager is organised and the following actions:
   • Add Area
   • Tasks
     o Find Page
     o Refresh
     o Apply Template
   • Publishing
     o Publish entire site

2. How to create a Site Area using the Site area form

3. How to create a new page from the Area Manager and the Page Manager

4. The parts of the new Page form

5. How to create multiple pages and copy a page or sections

Notes
Section Three - Adding Content

Aims and Learning Objectives

This section will look at the components of Activedition that you will use to add content to your site. Here you will learn how to upload a Microsoft Word or Excel document as a Web Page, Browse the draft version of the site and edit it using the Page Editor. You will learn the different ways to place non-textual elements such as multimedia to a section, and how to publish Areas and Pages. After this section you will have learnt the following:

- Upload an Office document as a Web Page.
- The use of core content editing tools.
- Understanding the Page Explorer, browse through the site, edit and save text based content using all of the features of the Page Editor.
- How to place multimedia, links and form elements on an editable content section.
- Placing links pictures and forms on a page and manipulating them to appear where and how you want.
- Adding and Managing page comments
- Publishing pages and areas.
Lesson Seven - Uploading an Office Document

Version Four allows a Microsoft Word or Excel document to be uploaded into Activedition as a complete page of content in an Area of your choice. Any External links and Multimedia associated with that document will be uploaded into the respective Libraries. There are a number of different ways to upload an Office document.

To Open Office Upload

- From the Main Explorer click the Office Upload link in the Site Management group.
- In the Area Manager click onto the required Area, hover mouse over the Add option and select Office Upload.
- In the Page Manager click onto the Area name, hover mouse over the Add option and select Office Upload.

Uploading a document

The Office Upload form opens on the right hand side and has the following options:

Page Name
Enter the required page name here. The page name is used as the name for the file that is published to the live website, e.g. a page called ‘contact’ in the home area would be published to http://www.mysite.com/web/site/home/contact.asp. The name will also be used in the listing in the Page Manager and elsewhere in Activedition. The page name must not contain spaces. The page name must be unique site wide.

Page Title
Enter the required Title name here. This is used on the title seen in the blue bar at the top of the browser. The title is also used as the default text for the link to this page that is added to the link library when the page is created.
- Page Template
  Select the required template here. A template has to be selected prior to document upload, failing this will result in an error message being displayed.

- Style Sheet
  Select the required Style Sheet here. If no Style Sheet is selected the uploaded page will use the selected area style.

- Area
  Select the required area for the uploaded page here. The areas are listed in ascending alphabetical order. Only those areas that you have access to will be displayed.

- Multimedia Library
  Any multimedia that is placed on the original document will be uploaded to a library of your choice. Only those multimedia libraries that you have access to will be displayed. If you do not have access to any multimedia libraries only the default option will be available.

- Office Document
  Either type in the path name for the document or click onto the Browse button to launch the File Manager and locate the file from here. Once located clicking onto the Open button will add the required path.

Once the selections are made, click onto the Upload button to complete the page creation. If successful the page will be launched in Browse and Edit for further editing.

Important Considerations. There are two things that you need to do or be aware of to ensure that ‘Office Upload’ functions correctly:

1. Office Upload can upload Word documents from ‘Office 97’ through to ‘Office 2007’, and Excel documents from ‘Office 97’ through to ‘Office 2003’.

2. In your browser go to Tools/Internet Options/Security, select the ‘Internet’ option then click onto ‘Custom Level’.

3. Scroll down to the ‘Initialize and script ActiveX controls not marked as safe’ and ensure ‘Prompt’ is selected then click OK. If security is an issue then you might want to add this site to your Trusted Sites and then set Custom Level for ‘Trusted Sites’ rather than ‘internet’.

Exercise: Uploading a document

1. Upload a Word document of your choice.
   a. Enter the page name myname_word.
   b. Enter the page title myname_word.
   c. Select an appropriate template and stylesheet.
   d. Select your sub area in the training area.
   e. Select the default library for any multimedia uploading.

2. Upload an Excel document of you choice.
   a. Enter the page name myname_excel.
   b. Enter the page title myname_excel.
   c. Select an appropriate template and stylesheet.
   d. Select your sub area in the training area.
   e. Select the default library for any multimedia uploading.
Lesson Eight - Browse and Edit, Page Explorer and Page Editor

Browse and Edit is by far the most used tool in Activedition to edit content. It offers the facility to browse through the draft version of the website within the context of Activedition, editing content where you are allowed to do so. There are a number of different ways to open browse and edit:

To Open Browse and Edit

- From the Main Explorer click the Browse and Edit Link in the Site Management group. This will open browse and edit at the home page, or at the last page viewed in browse and edit.

- Click onto the Site Management link in the toolbar. This will reveal the Browse & Edit link, clicking on this will open browse and edit at the home page, or at the last page viewed in browse and edit.

- In the Page Manager right click a Page and choose the Explore Page option or left click onto Page. This will open the specific page you have chosen in Browse and Edit.

The Browse & Edit interface is a single screen editor that allows content to be entered directly into the Page Editor or placed from the Page Explorer.

The Page Explorer

When Browse and Edit is launched the Page Explorer bar on the left hand side will be minimised. Hovering the mouse over the Page Explorer title bar will reveal the Explorer content, this will display a graphical representation of the sections on the page currently displayed in Browse and Edit, and of the library items placed on those sections; this view is updated whenever you navigate to a new page. Moving the mouse away from the Explorer bar will cause the bar to minimise. Clicking onto the pin icon in the Page Explorer title bar while the Explorer bar is displayed will fix the Explorer bar so that it will remain displayed when the mouse is moved away. Clicking onto the pin while the Explorer bar is fixed will enable the bar to minimise when the mouse is moved away.

- Each of the Nodes of the tree view: the Page Name, Section Name and Placed Library Item Names, show menus with relevant editing options when clicked.

- Switching Browse and Edit off at the top of the Page Explorer, displays the task manager in the right hand pane rather than the draft version of the site. If any items in the tree view are edited the forms appear in this pane rather than a new window. This can be useful when working over a slower internet connection. Clicking onto the filter button to the right of Filters will hide this option.
- By default *Browse and Edit* ignores date validity so that you can edit all sections of content regardless of any validity set. Choosing and applying a date will show the site as it would appear on the selected date. This date filter will apply on all pages that are visited until the *Ignore* option is selected. Clicking onto the filter button to the right of *Filters* will hide this option.

- The Page Explorer can be used to:
  - Add and Edit Sections, Edit page properties
  - Place Library Sections on a page, place other Library items on a section
  - Copy Sections from one Page to another
  - Edit Library Placement details
  - View Statistics
  - Submit the page for publishing
  - Edit Metadata

**Adding Sections**

Sections are used to display content; content can be added to sections directly using the Page Editor or copied and pasted from an external document. The numbers of sections that can be added to a page are determined by the applied template, for example a template that only supports two sections will allow more then two sections to be added in the *Page Explorer* but will only display two in the *Page Editor*.

**Note:** If when opening a page in the Page Explorer for the first time a section icon is not displayed then this may be because an *autoadd* attribute has not been applied against the section in the template. A section can still be added providing the template supports sections.

**To Add a Section**

Right mouse click onto the page name in the Page explorer, hover mouse over *Add* and select *Section*. The *Add New Section* form will be displayed and is broken down into the following five Tabs:

- General
- Content
- Availability
- Advanced
- Meta Data

**General**

The General Tab displays the Name field for the section this is a mandatory field and is initially populated with the name *Text_Section*. The section name doesn’t need to be unique unless it is a library section, it is for reference in the *Page Explorer*, and it does not appear on the live website. A max of 20 characters can be entered.
Content

The Content Tab displays the **Page Editor** (see using the Page Editor) which allows content to be added into the section, this tab is displayed by default.

<table>
<thead>
<tr>
<th>General</th>
<th>Content</th>
<th>Availability</th>
<th>Advanced</th>
<th>Meta Data</th>
</tr>
</thead>
</table>

**Editor**

The editor allows for content to be added into the section.

**Options**

- Spell Check

Availability

In the same way that date validity can be set on Pages it can be set on Sections. This can be used to rotate content or set up events Pages etc.

<table>
<thead>
<tr>
<th>General</th>
<th>Content</th>
<th>Availability</th>
<th>Advanced</th>
<th>Meta Data</th>
</tr>
</thead>
</table>

**Validity**

- Display From
- Display Until
- Choose / Clear

Advanced

The advanced tab has three settings:

- **Parent Page**
  Indicates the Page this Section belongs to, changing this to another Page moves this Section to that Page.

- **Library**
  This allows the conversion of the section to a library section that can be used elsewhere on the site and centrally managed from the Section Library.

- **Order**
  This refers to the order of this section relative to other sections placed on the Page. Set the order value lower than another sections order value for the section to appear before it, higher to appear after.
Meta Data
If Meta Data fields are associated with sections you have the opportunity to edit them here. There are two options:

- **Type**
  The default is Section but if there have been sub meta types added these can be accessed by selecting them from the drop down list.

- **Edit on Save**
  This check box may already be populated which will display the Meta Form on Save, or you can select to edit the appropriate Meta Form by clicking onto this checkbox.

Adding Section (HTML)/Viewing Section Properties
Adding a Section HTML or viewing the section properties by either clicking onto the section or right mouse clicking then selecting Properties will either display a blank HTML content page or a page with HTML Content.

This screen allows the editing or amendment of placed HTML code.

Using the Page Editor in Browse and Edit
Once a section has been added it can be edited directly in the Page Editor by clicking onto the section placement (surrounded by dashed lines). This will change the colour of the dashed lines from blue to red indicating that this is the active section.
The Page Editor offers editing tools similar to those you would find in standard Word Processing software, plus some additional features and will also display added sections.

Save. To save content addition or changes click onto Save. If you navigate away from the Editor without saving, any changes made will be lost.

Save and Add a Section. To save contents and create another section select this tool.

Save/Move to Next Stage In Page Lifecycle. Selecting this tool will save the page and submit it for publishing, selecting the tool again will publish the page.

Cut, Copy and Paste, Paste Plain Text. Pasting from word will retain the entire general styling such as bold, italic headings etc, but allowing these styles to be controlled by the site branding, rather than the specific styles enforced by Word. Pasting Plain Text will copy text from Word, Internet Explorer, PowerPoint etc removing all formatting so that the text may be reformatted in Activedition using the styles defined in the site branding. Find/Replace is used to find text and replace if required in the Section Content. Standard keyboard shortcuts are supported (See Appendix A).

Unlimited Undo and Redo. Standard keyboard shortcuts are supported (See Appendix A).

Remove Formatting. Selecting this tool against highlighted text will remove all existing formatting.

Bold, Italic, Underline Formatting and Strikethrough. These are applied to the selected text. Standard keyboard shortcuts are supported (See Appendix A).

Superscript and Subscript. These are applied to the selected text.

Justification. Selecting any of the available justification tools will format highlighted text accordingly.

Text Alignment, Numbered and bulleted lists. Text Indentation level. These are applied to the current paragraph.

Drag and Drop. Select this tool to add either multimedia, links o forms to the page.
Check In/Check Out Page. If the page is not checked in, this tool will need to be selected
before the page can be edited. (Only visible if Check In /Check Out has been selected in
System settings)

Styles List. There are two Style Lists, Fixed and Custom. The fixed list is the left hand list
and will only display Heading styles that were created in the applied Stylesheet. The
custom list is the right hand list and will display user defined style classes; the addition of
these classes is normally a designer function.

Insert Table. This tool is used to add a HTML Table within the content.

Insert HTML Tag. Selecting this tool will enable you to add a tag that supports accessibility
standards.

Horizontal Rule. This will place an HTML Horizontal Line onto a Section.

Insert Special Character. This will access the following Character Subset tables:
  • General
  • Greek
  • Latin
  • Miscellaneous

Toggle Table Borders. This tool will display the table placement if the borders have been
set to 0.

Toggle Section Editing: This tool will switch Off/On the Section Editor.
Note: Items such as links and forms will not work unless the Editor has been toggled off.

Page Properties. This tool will access the Page Properties form.
Using the Table Editor

A table editor is also included with standard functions. Clicking the table button (circled) opens the create table dialogue.

<table>
<thead>
<tr>
<th>Table Structure</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>No. Rows</td>
<td>3</td>
</tr>
<tr>
<td>No. Columns</td>
<td>3</td>
</tr>
<tr>
<td>Border</td>
<td>1</td>
</tr>
<tr>
<td>Cell Padding</td>
<td>1</td>
</tr>
<tr>
<td>Cell Spacing</td>
<td>1</td>
</tr>
<tr>
<td>Width</td>
<td>100%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Caption</td>
<td></td>
</tr>
</tbody>
</table>

- **No of Rows and Columns**
  Entering the required figure in these fields will determine the number of rows and columns to be used in the table.

- **Border**
  The `border` attribute informs the browser to draw lines around the entire table and all of the rows and cells. The lines are shaded to give an embossed appearance. The thickness of the border line is declared in pixels as an integer.

  **Note**: Entering zero here will result in no border.

- **Cell Padding**
  The `cell padding` attribute sets the amount of white space to place between a cell wall and the contents of a cell. Declare the amount in pixels as an integer. The default is one pixel.

- **Cell Spacing**
  The `cell spacing` attribute sets the amount of white space to place between each
adjacent cell and between each cell and the outer border of the table. Declare the amount in pixels as an integer. The default is two pixels.

- **Width**
  The *width* attribute is used to set the width of a table. It can be declared either as an integer number of pixels or as a percentage of the width of the display window.

- **Summary**
  The *summary* attribute is used with non-visual media such as braille and speech to provide information about a table.

- **Caption**
  The *caption* attribute allows the placement of a comment (caption) with a table. The caption does not appear inside the table, but rather it appears outside the table on either the top (default) or bottom.

**Modifying the Table**

To the right of the *Insert Table* button is the *Modify Table* button, selecting this displays the Table Properties dialogue box consisting of two Tabs:

- **General**
  The General Tab will display the Table Structure attributes used to construct the table and are available for amending.

- **Advanced**
  The Advanced Tab will display the Table cell Groupings, here a summary or Caption can either be amended or added. Heading rows and Columns can be added here, the purpose of the header is to provide a caption, name, or information about the column of cells. The header text will be displayed in a bold font style.
Table editing options

When the cursor is in the table the other table editing options become available.

The following options are defined as follows:

- **Insert Row Above**
- **Insert Row Below**
- **Insert Column To Left**
- **Insert Column To Right**
- **Delete Row**
- **Delete Column**
- **Increase Column Span**
- **Decrease Column Span**
- **Increase Row Span**
- **Decrease Row Span**

**New Paragraph and Line Break**
Pressing the Return key will create a new paragraph. Holding the Shift key and pressing the Return Key will move to the next line without creating a new paragraph (a ‘soft’ return.)
Accessibility Tags

These options are used to add tags that support accessibility standards. Clicking each will show a dialogue for you to complete the language, title, cite URL and content as appropriate. HTML Tags and their usage are explained in full in the Activedition Accessibility Course, the brief explanations below are included as a guide only.

Tag Explanations

Acronym: The acronym tag is used to define any acronyms that are used in the section for example ‘BBC’. On the live site if the mouse is hovered over the acronym ‘BBC’ a tool tip reading ‘British Broadcasting Corporation’ will appear.

- Click onto $\text{<i>?</i>}$, the following dialogue box will appear:

| Element: | <acronym /> |
| Language: | [English] |
| Title: | British Broadcasting Corporation |
| Contents: | BBC |

- Press Create Element on completion, the acronym will appear in the section.
Div: The Div tag is used to separate blocks of content within a section so that a style or different format can be applied without affecting the other content within the section. It is rarely used and if so more likely to be used by Designers or Developers.

- Click onto , the following dialogue box will appear:

  ![Insert HTML Element]

  - **Element**: Select Div from the drop list.
  - **Language**: Entering a language will inform certain screen readers if used what language the div tag is in.
  - **Title**: This is the title of the Div tag for example ‘Horizontal Rule’.
  - **Contents**: This will display the div contents for example: <HR>

- Press Create Element on completion, the Div Tag will appear in the section.

Span: The Span tag is used for text different from main content for example a foreign language or an image caption.

- Click onto , the following dialogue box will appear.

  ![Insert HTML Element]

  - **Element**: Select Span from the drop list.
  - **Language**: Entering a language will inform certain screen readers if used what language the span tag is in.
  - **Title**: This is the title of the quote for example ‘Phrase’.
  - **Contents**: This will display the span contents for example: Jene sais quoi.
Tag Contents: This will display the span content for example ‘Je ne sais quoi’.

- Press Create Element on completion, the span tag will appear in the section.

Abbreviation: The Abbreviation tag is used to display abbreviation meanings.

- Click onto `?`, the following dialogue box will appear.

<table>
<thead>
<tr>
<th>Element: <code>&lt;q/&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Language:</td>
</tr>
<tr>
<td>Title:</td>
</tr>
<tr>
<td>Contents:</td>
</tr>
</tbody>
</table>

- **Element**: Select Abbreviation from the drop list.
- **Language**: Entering a language will inform certain screen readers if used what language the abbreviation is in.
- **Title**: This is the title of the abbreviation for example ‘ectetera’.
- **Contents**: This will display the abbreviation in a tool tip.

- Press Create Element on completion, the abbreviation will appear in the section.

Blockquote: The Blockquote tag is used to display long quotations.

- Click onto `?`, the following dialogue box will appear.

<table>
<thead>
<tr>
<th>Element: <code>&lt;blockquote /&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Language: <code>English</code></td>
</tr>
<tr>
<td>Title: <code>Reid Bombers never bla</code></td>
</tr>
<tr>
<td>Contents: <code>Mr Reid was asked if mir</code></td>
</tr>
<tr>
<td>Cite: <code>http://news.bbc.co.uk/1</code></td>
</tr>
</tbody>
</table>

- **Element**: Select Blockquote from the drop list.
Language: Entering a language will inform certain screen readers if used what language the blockquote is in.
Title: This is the title of the blockquote for example ‘Queens Speech’.
Cite: The URL of the quoted text.
Tag Contents: This will display the blockquote.

• Press Create Element on completion, the blockquote will appear in the section.

Quote: The Quote tag is used to display short quotations that do not require paragraph breaks.

• Click onto <q>, the following dialogue box will appear.

Element: &lt;q/&gt;
Language: English
Title: Hamlet
Contents: To be or not to be, that is

• Press Create Element on completion, the quote will appear in the section.

Additional Content Management Features in the Page Explorer

Other additional features in the Page Explorer are as follows:

• Page Menu:
  Tasks -> Delete Library Sections
  Allows you delete one or more Library Section Placements from the page.
  Tasks -> Statistics
  Allows you to view the number of times the page has been opened and on what date.
• Section Menu.
  Copy -> Section
  Similar to the Copy -> Sections option from the Page Menu, but for a single section. Once the section is copied the page copied to will be shown in Browse and Edit.
  Tasks -> Replace with Library Section
  Enables a section to be replaced with a Library Section from the Section Library.
• Library Section Properties
  Allows you to set the Section order and date validity on a per placement basis.
Exercise: Edit Textual Content

1. Create or edit a section on the myname_home page and name it myname_Main.

2. Use some textual content from the web. Using the Page Manager complete the following tasks:
   a. Add a heading to the included test using Heading 1 style.
   b. Add some bullet points.
   c. Add a table with 3 columns and rows ensure that the first row is a header row. Include your own choice of content into the table.
   d. Type the following sentence beneath the table ‘The WWW is great’ ensuring that ‘WWW’ is an acronym of World Wide Web.

3. Browse to the myname_Contact page and create or edit a section on the page and name it myname_Main. Edit the Section adding Address and other contact information, try and lay it out as you would expect a contact page on a live website to be laid out.

Notes
Lesson Nine - Using Drag and Drop

To add non textual elements to a Section you need to Place Items stored in one of the Libraries. You can do this and add new links and multimedia items from the Page Editor by using Drag and Drop.

Drag and drop is used by clicking onto the Drag and drop icon in the Page Editors toolbar and allows you to place Multimedia, Links and Forms onto a section by dragging them to the appropriate position in the editor, and to add new links and multimedia items to the libraries.

Placing Multimedia

- Open Drag & Drop, by default the Multimedia type is selected.

- Select the Library that the Multimedia is stored in or choose Show All Files.

- If you know the name or part name of the item you want to place Enter it in the Search textbox.

- If you know the File type, select it from the drop list. If the file type isn’t listed but you know it exists in the Library you will have to place the item from the Page Explorer (Drag & Drop doesn’t support all file types).

- Click the Go / Refresh button to apply the filter criteria you have selected.

- If necessary use the First Previous Next Last buttons adjacent to the numbers of multimedia found to find the image you want to place, or select the page number from the droplist.

- Clicking any of the images listed will display a preview at the foot of the Drag & Drop page.

- When you find the image you want to use, you can drag this preview image to the correct position in the section content. This will both locate the item within the content and Place the Item on the Section, becoming visible in the Page Explorer once the page has been saved.
Placing Links and Forms
Drag and drop for Links and Forms work in exactly the same way as Multimedia above.

- Choose a placement type of Links or Forms
- Use any available filtering to find the item you want
- Click the item you want to place and a *dragable* copy of it will appear at the foot of the Drag & Drop Selection page.
- Drag the item at the foot of the Drag and Drop page to the appropriate location in the Page Editor content.

**Note:** Forms and certain multimedia types will not be shown initially in full within the Page Editor until the page has been saved; rather they will be represented by an icon. Also note that links either internal or external and Forms will not work unless the Editor has been toggled off.

Creating image links with Drag and Drop
To add an image that acts as a link to another part of the site complete the following procedure:

- Drag and Drop the desired link into the *Page Editor Content* at the appropriate location.
- Drag and Drop an Image into the centre of the link, the link text will disappear and be replaced by the image.
- Save the changes made.

**Note:** Should the image appear to ‘split’ the text rather than replace it when viewing it once saved in the *Page Editing* screen, then the link has not been placed within a paragraph. To resolve this:

- Click onto the relevant section in the Page Explorer and select Properties.
- Locate the `<aelinkpic>` tag and place a `<P>` tag before it.
- Locate the second `<aelinkpic>` tag and place a `</P>` tag after it.
- Save the changes.
Adding New Pictures
To add new multimedia items to the libraries you are authorised to manage:

- Open Drag and Drop.
- Click the Upload Multimedia link.
- Choose the image / item by browsing your PC, note that the file name should not contain spaces.
- Choose the library that you want to upload the item to.
- Enter a description, this will be used as the default alternative text used for the image, this field may be mandatory depending on the accessibility settings configured by an Administrator.
- Upload the item by clicking the Upload File button.
- The Item will now be available to Drag and Drop into the content.

Adding New Links
If the Create Link in Link Library check box was not ticked when a page was created then the page cannot be linked to, to overcome this a link can be created to that page through the Link Library:

- Open Drag and Drop
- Choose the Links placement type and choose the type of link that you want to add, if an internal link is being added a Site Area will also need to be selected.
- Click the Create a Link link.
- In the General Tab enter a Name Tag, this is for internal reference within Activedition and should not contain spaces.
- Enter a Description; this will be used as the default text for the link.
- Enter the appropriate details in the appropriate textbox, an email address for an email, web address for an external link. Web addresses do not need the http://.
- In the Accessibility Tab enter an Access Key; this will be the default access key for the link.
- In the Advanced Tab if displayed, edit any other fields as appropriate (e.g. Target for an External Link).
- Save.
- The Link will now be available to Drag and Drop into the content.
Exercise: Using Drag & Drop

1. Place some images from the multimedia library onto the myname_home page.

2. Place links to pages you have created onto the home page, in Browse and Edit follow those links then place links back to the myname_home page.

3. Create an external site and an email link; place these links onto one of the pages.

4. Upload a new image to the default Library, place this on any of the pages created.

5. Place any form on the myname_members page.

6. Create a picture link.

7. Use the Page Editor to delete a picture and link placement.

Notes
Lesson Ten - Using the Page Explorer

The Page Explorer offers an alternate method of placing Library Items, and extended options for editing Item placements. When an item has been placed on a section, either through Drag and Drop or the Page Explorer it will appear in the Page Explorer tree view. Clicking that item will then display a menu of management options available.

Placing and Managing Multimedia
To place Multimedia click the section in the Page Explorer that the Multimedia is to be placed on and choose the Place- Multimedia option. The Multimedia Placement form that is displayed has filter options similar to those in Drag and Drop, the items are listed with more detailed information:

- Filters
  There are three filters that can be applied; filters can be hidden by clicking onto the button on the far right hand side.
  - Library
    Either choose All, Default, or a library that you have access to.
  - Search
    Either type in part or all of the multimedia name and select Go or select Show all to display all multimedia files.
  - Uploaded File Types
    The dropdown list will display all uploaded file types.

- Select
  To place an item on the Section tick the checkbox on the left of the details, you can place multiple items from one page of results, i.e. without clicking the next / previous links. Once all the items to be placed have been marked then either Save to return to the Page Explorer or Save and Edit Section to open the Page Editor so that you can move the images into context as appropriate. Once the Multimedia has been placed it will appear in the tree view, clicking the item here allows you delete the placement or edit the properties.

- Name
  The Item Name is shown here.

- Order
  If several images are being placed on a section at once, and there is no intention to move them manually once placed, their order relative to each other can be controlled by this field.

- Description
  This is the default text used in for the Alt attribute on the image (used for the image tool tip and accessibility).
More
Clicking onto this link will display a multi-tabbed dialogue box:

- **General**
  - **Multimedia Description**
    This is the default text used in for the *Alt* attribute on the image (used for the image tool tip and accessibility).
  - **Alternative Description**
    If you want to override the default Description for this placement you can do so here.

- **Preview**
  Clicking the preview tab will display the image / Multimedia item.

- **Accessibility**
  - **Multimedia Long Description**
    This is an alternate page used to describe complicated images such as graphs, this is used in the *longdesc* attribute which is a requirement for certain accessibility standards and is set in the Multimedia Library.
  - **Alternative Long Description**
    If you want to override the default Long Description for this placement you can do so here by using the link to select the alternative long description page.

- **Advanced**
  - **Order**
    If several images are being placed on a section at once, and there is no intention to move them manually once placed, their order relative to each other can be controlled by this field.
  - **Horizontal Alignment**
    This controls whether the Image is aligned left with the text wrapping to the right, or aligned right with the text wrapping to the left.

**Placing and Managing Links**
Link placement from the Page Explorer is very similar to the Multimedia placement above, extended properties are as follows:

<table>
<thead>
<tr>
<th>Select</th>
<th>Name</th>
<th>Order</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
</table>

- **Name**
  This is the link name.

- **Order**
  As with Multimedia, if the links aren’t going to be moved into context their order relative to each other can be set here.
- Description
  This is the default link text as stored in the Link Library.

- Status
  The status of either Page Valid or Page Invalid will appear.

- More
  Clicking onto this link will display a multi-tabbed dialogue box:

  o General
    • Link Title
      A tool tip will be displayed with the Link Title when the mouse is hovered over the link.
    • Alternative Description
      If you want to override the default Description for this placement you can do so here.

  o Accessibility
    • Alternative Access Key
      Allows you to override the access key for this link stored in the link library. Pressing Alt+ the access key will take focus to the link so that it can be clicked by pressing return. This is included to support accessibility requirements

  o Advanced
    • Order
      If several links are being placed on a section at once, and there is no intention to move them manually once placed, their order relative to each other can be controlled by this field.
    • Override Link Target
      Allows you to override the Link Target for this link stored in the link library. This specifies whether the link opens in the same window, a new window or named frame or window.
    • Alternative
      if the link target is to be overridden then an Alternative target needs to be selected.

Once the link has been placed it will appear in the tree view, clicking the item here allows you to delete the placement or edit the above properties.

Placing and Managing Forms
To place a form:

• Click on the section you want to place a form on and choose Place -> Forms.

• Select the form type you require, choices are Form or Poll.

• Select the form you want to place from the list.

Once Forms are placed you can delete the placement or view the Form by choosing the View -> Form option.

Note: Only one form or poll can be placed onto a section.
Placing and Managing Tags

Tags are snippets of code added by System Administrators; they could be anything from a news ticker to a sitemap, a section layout utility to a webcam. Tags are always placed above a section.

To Place a Tag:

- Click on the section you want to place a tag on and choose Place -> Tags.
- Select the tag(s) you want to place from the list by clicking onto the Select check box.
- The Tag placement properties will be displayed, attributes may be available depending on the tag and can be selected prior to placement.

Once placed you can delete the placement or edit the order of the placed tags relative to other tags from the Page Explorer.

Adding New Sections

To add a new section of editable content to a page, click the Page Name in bold at the top of the Page Explorer and choose

- Add -> Section
  This will open the Page Editor, allowing you to edit and save the content of the new section.
- Add -> Section (HTML)
  This will open the section properties form, allowing you to code the HTML source directly. Instructions are at the foot of the form for manually locating placed items from libraries in the content, and for manually creating image links.

Once a section has been created you can view the HTML source at any time by clicking it in the Page Explorer and choosing the Properties option.

The applied template determines where sections appear on the page, although you can control the order that they appear in. If you add a section and it is visible in the Page Explorer but not Browse and Edit, then more sections have been added to the page than are allowable by the template. This will not cause any errors but the section will not be visible on the live website.
Using Library Sections

Library or shared sections can be used on any number of pages on the site, but are centrally managed in the section library. If you have authorisations to edit you will be able to edit it in the Page editor.

Placing a Library Section

In the same way that Multimedia, Links, Forms and Tags are placed on a Section, Library Sections are placed on the page. The Section placement form is very similar to the other Item Placements and can be accessed by clicking the Page Name in bold at the top of the tree view and choosing the Place->Library Section option.

Replacing Sections with Library Sections

Existing Sections can be replaced with Library Sections in by clicking the Section in the Page Explorer and choosing the Tasks -> Replace with Library Section Option. Note that this will delete the section that is replaced.

Adding a Section to the Section Library

Existing Sections can be saved to any Section Library that you have access to edit by opening the Section Properties, and click onto the Advanced Tab. Select the required Library from the dropdown list. The name of the Section needs to be unique site wide and only the underscore '_' character is allowed. The name is changed by selecting the General Tab; the name field is then available for amending.

Once saved the section will be placed in the selected section Library and available for use on other pages.

The Library Section is identified within the Browse and Edit screen as having a red cross placed on to the Section icon.
Exercise: Using the Page Explorer

1. Create a section on any page and place any available tag on it.

2. Place an external link onto the section then edit the properties of the link as follows:
   a. Change the description
   b. Change the access key
   c. Change the target

3. Place an image onto the section then edit the properties of an image as follows:
   a. Change the description
   b. Add a long description
   c. Edit the alignment

4. Delete a section

5. Replace a section with a library section, set the validity for the future

6. View the page with date validity for today.

Notes
Lesson Eleven - Adding and Managing Page Comments

Page creators are able to add links to their page that allows the audience to add and view comments relating to the page subject. Once a comment has been added this will not be displayed until either an Administrator or a Content Contributor with access to that page approves the comment. When approved the comment is then available for viewing on the page by anyone who selects the View Comments link.

The Comments feature works by the placement of the View Comments tag from the Tag Manager onto the required page:

Placing the View Comments tag

- Right click onto a section where you want to place the comments link, hover mouse over Place then select Tags.

  Note: It is possible to place a comments link on more than one section within a page, however this is not deemed as good practice.

- In the Tag Placement screen select Show All in the Library droplist and from the displayed list select the View Comments tag.

<table>
<thead>
<tr>
<th>Select</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View Blog Comments</td>
</tr>
<tr>
<td></td>
<td>View Comments</td>
</tr>
</tbody>
</table>

- On selection the Tag placement Properties screen will be displayed.
The following three parameters are available:

- **Email Mandatory**
  - No (Default)
  - Yes

- **Show Email**
  - On (Default)
  - Off

- **Comment Order**
  - Latest (Default)
  - Earliest

On completion click onto the Save button, and then Save again.

**Using the Add Comment Link**

Once the page has been published a comment can be added by anyone viewing that page:

- Click onto the *Add Comment* link.

  ![](Training > C2 Software News Page Add Comment View All Comments (0))

- In the Add Comment form there are three editable fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Finlay Carmichael</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td><a href="mailto:finlay@c2software.com">finlay@c2software.com</a></td>
</tr>
<tr>
<td>Comments</td>
<td>Comments are added to this field, once moderated they can be viewed</td>
</tr>
</tbody>
</table>

- **Name**: The name of the commenter is added here; if the commenter is logged into the site then this field will be completed.

- **Email**: A valid email address for the commenter is added here; if the commenter is logged into the site then this field will be completed.

- **Comments**: Comments for the page are added here, these will not be viewable until the comments have been approved.

**Approving Comments**

Comments added on a page need to be approved before other users of the site can read them:

- Right mouse click on the required page in *Page Manager*, hover mouse over *View* then select *View Comments*. 
In the Page Comments screen you can view all Approved and Unapproved comments, the default is Unapproved.

In this screen you can:

- Approve/Delete Comments by either clicking onto the All link or ticking the appropriate checkbox(s) then select either the Approve or Delete buttons. If Approve has been selected then that comment can be viewed on the page, if Delete has been selected then it will no longer be available.

- Edit the Comments by Clicking onto the edit link:
In the *Edit Comment* screen the following fields are available:

- **Name**: This will be the name of the person adding the comment.
- **Email**: This will be a valid email address.
- **Comments**: This is where the comments for the page are entered; currently there is no limit to the number of words that can be placed here.

Click onto the *Save* button when completed

You can view approved comments in the *Page Comments* screen by selecting *Approved* from the Show droplist where you can either delete or edit them.
Viewing the Comments

Once the Comment has been approved it can be viewed from the published page by clicking onto the View All Comments link.

Selecting the View All Comments link will display all comments associated with this page.

In this view the audience can read the comment(s), add a further comment or email the comment originator.

To return back to the original page click onto the Hide Comments link.

Exercise: Adding and Managing Comments

1. Place the Add and View Comment Tags onto a page of your choice.
2. Publish the page and add a comment.
3. Edit the comment then approve it for viewing.
4. Return to the published page and view the comment.
5. Delete the comment.

Notes
Lesson Eleven - Publishing

After all the required changes have been made to a page it will still not appear on the live website and needs to be published to do so. Depending on the authorisations a Content Contributor has, they may or may not have the ability to publish the pages they have edited.

If workflow is enabled in the system a page will have to be submitted for publishing regardless of whether the Content Contributor has authorisations to publish or not, otherwise a page can be published directly.

Notification Lists can be set up by Administrators so that whenever a page changes status users are informed by email, in the task manager or both. E.g. a Content Contributor with publishing rights for a particular area may be informed whenever pages are moved to the awaiting publishing status for that area so that they can review and publish/reject the content.

Note: Notification Lists require workflow to be enabled.

Submitting an item for publishing and moving to draft

When a page is submitted for publishing its status will have changed to A - Awaiting Publishing, the page properties will not be available from the Page Manager unless it is moved back to Draft.

If the page is Explored in Browse and Edit and updated, or the page properties are edited from the Page Explorer, it will automatically be moved to Draft.

- From the Page Explorer
  Click on the Page Name and choose the Publishing -> Submit for Publishing option. This will close the Page Explorer and return you to the Page Manager for the Area that the Page is in.

- From the Page Manager
  Click on the page that you want to publish and choose the Publishing -> Submit For Publishing or Publishing -> Submit For Publishing with Comments option. If you choose to add comments these will be included in any Notification List messages.

- Submitting an Area For Publishing
  An Area can be submitted for publishing either through the Area Manager or the Page Manager, this will submit all pages for publishing regardless of status. You cannot add comments when submitting an area.

Similar options are available to move pages to draft, either with or without comments. If you move an item to Draft with Comments from the Page Manager only people on a Notification List that informs users when pages move to draft in that area will be sent the comment, if the user who submitted the page for publishing is not the member of such a list they will not receive notification.
Publishing

- To publish a Page click onto the Page and Choose the Publishing -> Publish option in either the Page Manager or the Page Explorer.

- To publish an Area click the area and chose the Publishing -> Publish Area option from either the Area Manager or the Page Manager. if the pre-check fails you will be informed of the reasons why. If workflow is enabled trying to publish an Area will fail the check if all pages in that Area don’t have a Status of Awaiting Publishing.

Once publishing has started a confirmation message will be displayed detailing that the publish has commenced. Click on the Continue command Button to complete the publish request.

When the publish has completed a task will be sent to the Task Manager for the User responsible for publishing the page informing them of its completion.

Exercise: Publishing

Note: An administrator must grant you Publishing rights on the myname_home area to complete this exercise.

1. Submit a page in the myname_home area for publishing from Browse and Edit.

2. Submit a page in the myname_members area for publishing with comments from the Page Manager.
3. Use the workflow status report to reject the page in `myname_home` with comments.

4. Submit the `myname_home` area for publishing.

5. Publish a single page in the `myname_home` area from the Page Manager.

6. Publish the `myname_home` page from the Area Manager.

7. Place a link to the `myname_home` page from the site homepage and publish it.

8. View the live site and navigate through the pages.
Additional Site Management Features

Find Page
Will find a page in the system based on page properties or content, properties for a page in draft can be edited and the page can be explored in browse and edit.

Meta Data Search
Returns all items in the system containing the search text in any Meta type attributes associated with that item. The creation of Meta Data and its concepts are explored in greater detail in the Administration manual.
Lesson Summary

In this section you learnt:

1. The following functions of **Browse and Edit**:
   - Opening **Browse and Edit**
   - The **Page Explorer**
   - Editing Section Content.

2. The functions of the **Page Editor** interface

3. How to add the following items using **Drag and Drop**
   - Placing Multimedia
   - Placing Links and Forms
   - Creating image links with **Drag and Drop**
   - Adding new pictures
   - Adding new links

4. How to add the following items using the **Page Explorer**
   - Placing and Managing Multimedia
   - Placing and Managing Links
   - Placing and Managing Forms
   - Placing and Managing Tags
   - Adding New Sections
   - Using Library Sections

5. How to submit an item for publishing from:
   - The **Page Explorer**
   - The **Page Manager**

6. How to submit an Area for publishing from:
   - The **Area Manager**
   - The **Page Manager**

7. How to Publish a Page from:
   - The **Page Explorer**
   - The **Page Manager**

8. How to Publish an Area from:
   - The **Area Manager**
   - The **Page Manager**

9. How to add and manage page comments.
Section Four - Libraries

Aims and Learning Objectives

This section will look at the Libraries that hold resources such as Multimedia and Forms. Here you will learn how to use the available Libraries for creating, deleting, storing and viewing placements of the resources held. After this section you will have learnt the following:

- How to manage the resource libraries used in the system.
- The various library structures and how they are used.
- Uploading files and images, editing and creating links.
- Uploading Replacement files.
- Verifying External Links.
- Multimedia Item Properties.
- Using the Multimedia Library.
- Newsgroup properties.
- Newsgroup Moderation.
Lesson Twelve - Section Libraries

The Section Library allows sections to be managed on a per library basis and update permissions for Content Contributors set via the User Manager. Sections in the library are created in the same way as ordinary sections benefiting from all central libraries (e.g. multimedia, links, etc). Sections in the library can have valid from and to dates as per ordinary sections; these can be overridden for a particular section placement on a page.

Sections in the library can be published individually and impact all placements of the library section. As with other libraries Content Contributors don’t have any publishing authorisations, for individual library items. If a Content Contributor wishes to publish a particular library section they must publish a page having that section placed on it.

The menu available on each section in the library is the same as is visible in the page explorer with the addition of two options:

- **View->Section Preview**
  Sections are not part of a page or area whilst in the library, meaning that by default no stylesheet is applied. This option allows you to see how the section will appear with different style sheets applied, giving an appreciation of how it will appear when placed on a page.

![Section Preview](image)

- **View->Placements**
  This option will display a list of all the pages that a library section is placed on. Content Contributors will be offered the ability to Explore or Edit pages that they have been granted update authorisations for.

![View Section Placements](image)

**Shared Sections in Browse and edit**

- Existing sections can be made into library sections by simply choosing a library in the section properties. Note that Content Contributors can only save sections to libraries that they can update. Once a library has been saved as a library section it cannot be removed from the library unless it is deleted.

- Sections are placed on pages in the same way that other library items are placed on sections.
• When placing a Library Section “Set Validity” allows you to override the default validity of the section in the library. This can also be accessed through the properties of the placed section in the Page Explorer.

• Library Sections are clearly indicated in the Page Explorer with a different icon from a standard section.

Exercise: Using the Page Explorer

1. Create a section in the Section Library,
2. Preview the section as it would appear with different stylesheets applied.
3. Place the section on a page.
4. View the placements for that section in the Section Library.
5. Delete the section.

Notes
Lesson Thirteen - File Library

The file library lists all the uploaded files in the system, Content Contributors will only be able to access Libraries that they have been authorised to update. All Content Contributors will have access to the Default Library. If the Show All option is chosen, all the files in the authorised libraries will be displayed.

The File library offers the ability to manage the organisation of files in different libraries, download library files, upload file and edit Meta data and file properties.

New Files can be uploaded in a similar way to multimedia through drag and drop, this is available through clicking the name of the library in bold at the top of the tree view on the left and choosing the either the Upload Single File or Upload Multiple Files options.

File Properties
Clicking onto the File name then selecting properties will display a multi tabbed property sheet in the right hand pane giving you three options:

**General**
- **Name**
  This is used for reference in the File Library listing and when placing links to the file on a section. This is automatically generated from the filename when it is first uploaded, and can be changed as required once uploaded.
- **Description**
  Describes the file, when first uploaded the Description field is used to create a link to the file in the link library. To edit the default text of the link, update the link in the link library rather than the file Description.
- **Version**
  This indicates the number of times a replacement file has been uploaded. A file that has had a replacement uploaded once will have a version number of 2.
- **Belongs to**
  This indicates the Content Contributor or Administrator that first uploaded the file to the library.

**Advanced**
- **Library**
  Enables files to be reorganised within the file library. Changing this value and saving will move the file to the library selected.
- **Location**
  This is the location of the file on the server. This option should only be edited by advanced users, changing this will usually stop the file from being available for download via both any links placed on sections or through the File Library.

**Meta Data**
- **Options**
  If Meta Data fields are associated with the file you have the opportunity to edit them here.
Uploading a replacement file

Note that replaced files will not be available on the live website until published. While Administrators have the ability to publish directly through the File Library, Content Contributors can only do so by publishing a page that has the link to that file placed on section on it.

- Left click on the file that you want to replace in the list on the left
- Choose the Tasks -> Upload Replacement option
- Browse to the file that you want to use as a replacement on the local PC
- Click the Upload File button

Search Considerations

When performing a search in the File, Links, Multimedia, Form, Tag or Template Libraries the search is carried out on both the file name and description fields of each item. For example if a media file had a name of “Image001” and a description of “Computer Image” a search for either “Image” or “Computer” would return the Image001 file in the search results.

Exercise: Using the File Libraries

1. Upload 3 files to the File Library.
2. Download one of the files, edit it and upload it as a replacement.
3. Delete one file.
4. Place links to the file on a section on any page.

Notes
Lesson Fourteen - Link Library

The link library offers central management of all links that can be placed on sections and is organised into six pre defined libraries as follows:

- *Internal Web Pages* - Links to all the pages created in Activedition.
- *External Web Pages* - Links to other websites.
- *Email Addresses* - mailto links.
- *Newsgroups* - Links to the Activedition newsgroups.
- *Uploaded Files* - Links to files uploaded to the file library.
- *Local Files* - Links to files on a local file server, note that this will only work if the site users have access to the file server. Usually only used in an intranet.

Links in the *Internal Web Pages*, *Newsgroups* and *Uploaded Files* libraries are automatically created when pages, newsgroups and files are added to the system.

The Link library gives the ability to edit the link properties, such as the default text and address, view all the places where a particular link is placed on the site, delete unwanted links and check for broken external site links.

The new link form is the same as the one seen when using Drag and Drop. Selecting different link types will change the input options for a link. External links require a URL; Local Files require that you browse to the file etc.

To add a new link click **Link Library (<Library name>)**, choose the **Add Link** option and select the **Link Type** that you want to create prior to completing the form.

**Verifying External Links**

*An existing Link*

- Find the link that you want to validate in the link library
- Left click it and choose the **Tasks -> Verify Link**
- Click the Verify Button
- The results will give an indication of the link status, and the ability to visit the link

*A new Link*

- Choose **External Web Pages** from the Link Types Dropdown list.
- Click **Link Library (External Web Pages)** and choose **Tasks -> Verify New Link**
- Enter the URL for the new link and click the **Verify** button

*All Links*

- Choose **External Web Pages** from the Link Types Dropdown list
- Click **Link Library (External Web Pages)** and choose **Tasks -> Verify All Links**
- The links will verify on the right hand pane in groups of 5, use the First Next Previous Last links to navigate the results

**Viewing Placements**

Click onto the link and choose the **View -> Placements** option, this will display a list of all Link Placements. Content Contributors will be offered the ability to **Explore** or **Edit** pages that they have been granted update authorisations for.
Exercise: Using the Link Libraries

1. Edit the default link text of an uploaded file.
2. View the placements for a link to one of the pages created earlier.
3. Create a page and don’t add a link in the link library, create a link to the page through the link library.
4. Validate an existing external link.
5. Validate a new external link.
6. Validate all external links.
7. Create an uploaded file link.
8. Create an external link.
9. Create an email link.

Notes
Lesson Fifteen - Multimedia Library

Similar to the File Library, the Multimedia Library lists all the uploaded multimedia in the system. Multimedia can include images of different file types, flash and other movies, sound files and so on.

The Multimedia Library allows Administrators to create new libraries, Content Contributors will be able to upload to and edit items in Libraries they have been assigned update authorisations for.

Multimedia Item Properties
Clicking onto the Multimedia name then selecting properties will display a multi tabbed property sheet in the right hand pane giving you five options:

General
- **Name**
  This is based on the file name uploaded into the multimedia library and is used for reference in the multimedia library and when making placements.
- **Description**
  This is used as the default ‘alt’ text on the image (the tool tip seen when holding a mouse over the image).

Preview
This tab displays a preview of the item.

Accessibility
- **Long Description**
  Used for meeting certain accessibility requirements, this allows you to specify the Activedition page used to explicitly describe the content of a complex image, such as a graph.

Advanced
- **Library**
  This is the library that the Multimedia Item is a part of, changing this and saving will move the Multimedia Item to the Selected Library.

  **Height and Width**
  When an image is uploaded the height and width is read from it. If these are edited the image will be stretched to use the sizes entered. It is recommended that this is not used and should a different sized image be required it be uploaded to the library.

Meta Data
- **Options**
  If Meta Data fields are associated with the Multimedia then you have the opportunity to edit them here.
Using the Multimedia Library

- **Upload new item**
  Click the **Multimedia Library** title at the top of the list on the left hand frame and choose either the **Upload Single or Multiple Multimedia Files** option. The description will be used as the alternative text for the image.

- **View Multimedia**
  Click the item and choose the **View -> Multimedia option**. Displays a preview of the item.

- **View Placements**
  Click the item and choose the **View -> Placements option**. This will generate a report of all the uses of a particular item on the site, you will be able to edit or explore any of the pages that you are authorised to edit and contain a placement.

- **Copy**
  Click the item and choose the **Tasks -> Copy** option. This option works very similar to **Copy Page**, whereby the image can be copied to a library of choice and a new multimedia name needs to be added.

- **Upload Replacement**
  Click the item and choose the **Tasks -> Upload Replacement option**. Similar functionality to the upload replacement option in the File Library.

**Multimedia Library Profiles**
For each library created within the Multimedia Library image profiles can be created by Right-clicking on the Library name and choosing the **Tasks > Image Profile** option. Image Profiles are global for the library they are created within and will be applied to all images imported into that library. Image Profiles allow pre defined image quality and size rules to be applied to imported images.

A main Image Profile is declared and subsequent sub Image Profiles added to it so for any image imported multiple versions of that image will be created as sub images. This is useful for creating main full size images of the same media file for different usage within a website.

**Search Considerations**
When searching within a Multimedia Library that has Image Profiles applied only the main profile images will be searched, if a sub image is required it must be navigated to from the parent image.

**Notes**
Using the Image Editor

The Image Editor allows an image to be manipulated from within the CMS rather than a second party Image Editor such as Photoshop Pro®. Using the Image Editor a number of tools can be used to manipulate the image.

- **Launching the Image Editor**

  In the Multimedia Library, right click onto required image and select *Edit Image*, the Image Editor will be displayed in the right hand window.

- **Cropping the Image**

  Highlight the area of the image that is required to be displayed by holding the right mouse key down and dragging the cursor around the image.
Select the cropping tool, the screen will be refreshed after which the cropped image will be displayed.

Select Save to retain the cropped image.

- **Flipping the Image**
  If the image is required to be flipped over click onto the Flip tool, the screen will refresh and the displayed image will have been flipped.

- **Rotating the Image**
  The image can be rotated 90° left or right using the left/right rotate tools or smaller degree divisions by using the Arbitrary tool. To rotate the image select the Rotate tool, the Rotate interface will be displayed on the image.
• Selecting Left or Right will rotate the image 90°, adding a value in the Arbitrary field then selecting the appropriate radio button will rotate the image that number of degrees when OK is selected.

• Mirroring the Image
Similar to flipping, the image can be mirrored so that it is facing the opposite way. This action is implemented by selecting the Mirror tool, on refresh the image will be mirrored.

• Resizing the Image
Rather than use 3rd party software to change the size of the image, resizing can now be implemented by using the Resize tool in the Editor. Select the Resize tool from the Editors tool bar, the Image Size interface will be displayed on the image; note that the interface can be moved away from the image as desired.
The image size can be changed by adjusting the Width and Height values, then select OK.

- **Resizing the Canvas**
The canvas can be expanded, for example to display text placements or to display a border around the image. Select the *CanvasSize* tool from the editor’s toolbar, the Image Size interface will be displayed on the image; note that the interface can be moved away from the image as desired.

In this example the canvas has been expanded above the image by adjusting the Height values and anchoring the image to the bottom centre.

- **Adding text to the Image**
Now that space has been created above the image, text can be placed using the *Text* tool from the editor’s toolbar. Firstly a position has to be selected from where the text is to appear, this is actioned by left clicking onto the desired location, the coordinates for the selection will be displayed in the bottom right hand corner. Next select the *Text* tool, the Text interface will be displayed on the image; as in other examples the interface can be moved away from the image as desired.

Once the available fields are completed, selecting OK will add the required text.
Exercise: Using Multimedia Libraries

1. Upload an image to the Multimedia Library.
2. Add an alternative description to the image.
3. Place the image on a page.
4. View Placements for the image and explore the page.
5. Resize the image then view the placement to observe the change.

Notes
Lesson Sixteen - Newsgroups

Newsgroups offer ready built forums for use in Activedition. As a Content Contributor you may have been assigned rights to Moderate a Newsgroup.

Moderation gives you the ability to approve postings to a Moderated newsgroup, where postings will not go live until they are approved, and to delete postings from moderated and unmoderated newsgroups.

When you open the newsgroup manager you will see a list of all the newsgroups that you can moderate. You will also be able to edit the properties of the newsgroup:

Newsgroup Properties
Clicking onto the Newsgroup name will display a multi tabbed property sheet in the right hand pane giving you two options:

General
- Name
  This is for reference within the Newgroup Manager and when placing links to the newsgroup.
- Category
  Newsgroups can be placed into categories which work very similar to libraries.
- Description
  This is used as the default text for links to the newsgroup when the newsgroup is first created. To update the default text for a link to an existing newsgroup you need to update the link library.
- Update Links
  When selected will amend the linked placements on save.

Advanced
- Allow Public Access
  If enabled users do not need to be authorised / login with an Activedition user ID to contribute to a newsgroup.
- Allow Anonymous Postings
  If allowed the user has the option of their username not being displayed with the posting.
- Allow Attachments
  Will display a dialogue box in the Newsgroup to facilitate attachments.
- Email New Posts To
  Postings will be sent to this email address regardless of whether the newsgroup is moderated or not. This allows the content of unmoderated newsgroups to be
- Moderated
  If a newsgroup is moderated postings will not be visible until they have been approved.
- Moderator Email
  This is the email address of the Content Contributor or Administrator that responsible for moderating the newsgroup. Every time there is a posting this
user will be emailed the posting and advised that they need to approve the postings for them to go live.

Newsgroup Moderation
To Moderate a newsgroup Right Click the Newsgroup and choose the Tasks->Manage Articles option.

Approving and Deleting Articles
- The Article Contents screen will indicate the number of unapproved articles in a thread in the Article Contents column. Click View Thread for the topic that you want to moderate.
- Read the posting by following the links on the right, returning to the thread by using the Thread link.
- Tick the checkboxes next to the postings you want to approve and click the Approve button.
- Should you wish to delete any postings, open the thread again, tick the checkbox next to the posting and click the Delete Button?

Deleting a thread
- Open the Article Contents screen, tick the checkbox next to the thread that you want to delete and click the Delete button.

Make Sticky
Making a thread Sticky allows it to remain at the top of the newsgroup at all times.
- Select the thread or threads that you wish to make sticky by clicking onto the adjacent checkbox.
- Click onto the Make Sticky button, this will update the Sticky property from No to Yes.

Remove Sticky
- Select the thread or threads that you wish to remove the Sticky property from.
- Click onto the Remove Sticky button, this will update the Sticky property to No

Exercise: Using Newsgroups

1. Place a link to a Moderated and Unmoderated newsgroup; you will need moderated authorisations for these newsgroups.

2. Create a new thread and 3 postings in each newsgroup.

3. Moderate the Unmoderated newsgroup and delete 1 posting, then delete the thread.

4. Moderate the moderated newsgroup and approve 2 postings, delete the third.

5. Make the second posting Sticky.

Notes
Section Four - Review

Lesson Summary

In this section you learnt:

1. How to use a Section Library by:
   • Creating a section in the Section Library.
   • Previewing the section.
   • Placing the section on a page.
   • Viewing the placements for a section in the Section Library.
   • Deleting a section

2. How to use File Libraries by:
   • Uploading files to the File Library.
   • Downloading a file, editing it then uploading file as a replacement.
   • Deleting a file
   • Placing links to the file within a section on a page.

3. How to use the Link Library by:
   • Editing the default link text of an uploaded file.
   • Viewing the placements for a link to a page.
   • Creating links to a page through the link library.
   • Validating an existing external link.
   • Validating a new external link.
   • Validating all external links.
   • Creating an uploaded file link.
   • Creating an external link.
   • Creating an email link.

4. How to use Multimedia Libraries by:
   • Uploading an image to the Multimedia Library.
   • Image Profile.
   • Adding a long description to an image.
   • Placing an image on a page.
   • Viewing placements for an image and exploring the page.

5. How to use Newsgroups by:
   • Placing a link to Moderated and Unmoderated Newsgroups.
   • Creating a new thread and postings in a Newsgroup.
   • Moderating Newsgroups deleting and approving.
   • Deleting a thread
Section Five - Managers

Aims and Learning Objectives

This section will look at the managers that are available to you such as the Form Manager and the Menu Manager. These managers will allow you to create, delete and manage Forms and Menus. After this section you will have learnt the following:

- How to create, delete, use and manage Forms and Polls using the Form Manager.
- How to create, delete, use and manage popup and tiered navigation systems through the Menu Manager.
Lesson Seventeen - Forms and Polls

All forms and polls placed on sections in Activedition are built using the form manager. This offers the ability to quickly create forms and polls and manage their responses.

Form responses can be either emailed to the appropriate person, stored in Activedition for online management or both, whereas poll responses are stored in Activedition for online management only. If the responses are stored online they can be viewed individually, collectively or exported to a CSV file for download.

Adding a Form

To add a new form click on the Form Manager at the top of the tree view, choosing the Add->Form option will display a multi-Tabbed Add New Form in the right hand pane.

Form Properties

The form has four tabs; General, Custom Form, Advanced, Meta Data.

General
- **Name**
  Used for reference in Activedition only, for form listings and placements.

- **Description**
  This will be displayed above the form in bold when it is placed on a section.
• **Layout**
  How the generated form will be displayed, there are three options:

  ○ **1 Column**

  Question 1
  ☐

  Question 2
  answer text

  ○ **2 Column (default)**

  Question 1
  ☐

  Question 2

  ○ **4 Column**

  Question 1  ☐  Question 2

• **Email To**
  The email address that any form responses are sent to. This option is mandatory if **Store Answers** is set to **No**.

• **Redirect To**
  The Activedition page that is displayed after the form is submitted, usually a ‘thank you’ page or similar.

• **Store Answers**
  Selecting **Yes** will store all form responses in Activedition for viewing and analysis. If an **Email To** address has been selected you can choose **No**.

<table>
<thead>
<tr>
<th>General</th>
<th>Custom Form</th>
<th>Advanced</th>
<th>Meta Data</th>
</tr>
</thead>
</table>

**Custom Form**

• **Custom Form**
  This advanced option is used by developers; it allows custom form handling scripts to be used. In this case answers will not necessarily be emailed or stored in the database.
Advanced

- **Library**
  Enables forms to be reorganised within the form library. Changing this value and saving will move the form to the library selected.

- **Anonymous Responses**
  If ‘Yes’ is selected the respondents name is not displayed.

- **Respond Once Only**
  If selected will only allow a logged in user to complete the form once.

Meta Data

- **Type**
  This allows you to change the Meta Data Type set against required form.

- **Edit on Save**
  Clicking on the checkbox enables you to edit the Meta Form associated with the Meta type selected.

Notes
Adding a Question

To add a question click onto required form then select the Explore Form option. In the Form Explorer click onto the form name then select Add Question. The Add New Question form will be displayed in the right hand pane. The following tabs are available; General, Advanced and Meta Data.

**General**

- **Name Tag**
  Used for internal referencing when exploring the form in the form manager only.

- **Type**
  Field Types as follows: (see opposite page.)
Two additional field types are available.

- **Hidden**
  This field allows you to send additional information with a submitted form that doesn’t necessarily require a user to fill them out. For example, a customer is filling out a form that allows them to purchase a product. You can embed the stock number or ID of the product in a hidden field so that you know which product they are trying to purchase.

- **Multiple**
  The multiple field is similar to the drop list field, except more than one value can be selected by holding down the Ctrl key when selecting values.

Other Options

- **Mandatory**
  If a Question is mandatory a client side check will be made to ensure that this field is completed prior to the form being submitted. Should a client have JavaScript disabled on their browser this will be ignored.

- **Default Value**
  If appropriate the option to enter a default value will be offered.
- Question Text
  Text that will be displayed as the question on the form.

### General Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form</td>
<td>1column</td>
</tr>
<tr>
<td>Order</td>
<td>40</td>
</tr>
<tr>
<td>Vocabulary</td>
<td>Not applicable.</td>
</tr>
</tbody>
</table>

### Advanced Settings

- **Form**
  This can be used to move the question to another form.

- **Order**
  Order relative to other questions in the same form.

- **Vocabulary**
  If appropriate the option to select a pre-defined vocabulary will be offered.  
  **Note:** For Drop List question types only.

- **Range**
  If the field is a Date, Decimal Number or Whole Number a range can be specified.

- **Upload Settings**
  If the field is File Upload a library for the upload can be selected and an option as to whether user can select a library is available.

- **Editor**
  Large Text fields can have access to a tiny MCE editor the type of editor can either be Simple:
or Advanced:

<table>
<thead>
<tr>
<th>General</th>
<th>Advanced</th>
<th>Meta Data</th>
</tr>
</thead>
</table>

**Options**

<table>
<thead>
<tr>
<th>Type</th>
<th>Question</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit on Save</td>
<td>[ ]</td>
</tr>
</tbody>
</table>

**Meta Data**

- **Type**
  This allows you to change the Meta Data Type set against required question.

- **Edit on Save**
  Clicking on the checkbox enables you to edit the Meta Form associated with the Meta type selected.
Form answer values from Fields and Meta Data (Advanced)

**Note**: The following is an advanced subject and probably best undertaken once you have gained a good period of experience with Activedition.

It is possible to create default Form answers from either Meta Data or Activedition Data Tables. For example to create a form that stores a post code from Meta Data and Forename and Surname from Activeditions User Table you need to complete the following process:

- For the post code answer as it requires information from Meta Data ensure that a User Meta Type Attribute for post code has been created. An Administrator or Sub Administrator will set this up for you.

- In the required form add a question of type **Small Text**, in this case ‘post code’.

- In the Default Value field add the following tag:
  
  `<aemeta name = “post code” />.

  **Note**: Speech marks have to be used around the Meta Data name.

  The syntax for this tag is:

  `<aemeta name = “name_of_meta_type_attribute” />`

- Providing the post code Meta Data field has been updated when creating the user the result will be rendered in the post code field of the form when the form is placed onto a page.

- As for the Forename and Surname answers we will be using the Forename and Surname fields from the User Data Table so this time the `<aefield />` tag will be used.

- In the required form add a question of type **Small Text**, in this case ‘forename’.

- In the Default Value field add the following tag:

  `<aefield name="forename" type="user0" />`

  The syntax for this tag is:

  `<aefield name = “field_name” type = “data_table” />`

  Only the user0 table is used with this tag and other available field names to use are:

  - Surname
  - Email
  - ID

  Providing the forename has been added when creating a user and also providing that the user is logged onto the site where the form is placed then the users’ forename will be displayed in the form.
Adding a Poll

To add a new poll click on the Form Manager at the top of the tree view, choosing the Add-Poll option will display the Add New Poll form in the right hand pane. The following tabs are available; General, Custom Poll, Advanced and Meta Data.

![Poll Properties: members_poll](image)

### General
- **Name**
  Used for reference in Activedition only, for poll listings and placements.

- **Description**
  This will be displayed above the poll in bold when it is placed on a section.

- **Redirect To**
  The Activedition page that is displayed after the poll is submitted, usually a ‘thank you’ page or similar.

### Custom Poll
- **Yes/No**
- **Method**
  Please Select -->
- **Action**

---

*Copyright 2010*
Custom Poll

- **Custom Poll**
  This advanced option should only be used by developers; it allows custom poll handling scripts to be used. In this case answers will not necessarily be emailed or stored in the database.

### Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library</td>
<td>NoPreferredLibrary</td>
</tr>
<tr>
<td>Anonymous Responses</td>
<td>Yes  No</td>
</tr>
<tr>
<td>Respond Once Only</td>
<td>Yes  No</td>
</tr>
</tbody>
</table>

**Advanced**

- **Library**
  Enables polls to be reorganised within the poll library. Changing this value and saving will move the poll to the library selected.

- **Anonymous Responses**
  If ‘Yes’ is selected the respondents name is not displayed.

- **Respond Once Only**
  If selected will only allow a logged in user to complete the poll once.

**Meta Data**

- **Type**
  This allows you to change the Meta Data Type set against required poll.

- **Edit on Save**
  Clicking on the checkbox enables you to edit the Meta Form associated with the Meta type selected.

**Notes**
Adding a Question

To add a question click onto required poll and select *Explore Form*, in the *Form Explorer* click onto poll name and select *Add Question* this will display the *Add New Question* form. Only a single question can be added to a poll, if more questions are required than other polls need to be created. The following tabs are available; General, Advanced and Meta Data.

### General
- **Name Tag**
  Used for internal reference when exploring the poll in the form manager only.

- **Type**
  Only the Radio Button option is available for polls.

- **Default Value**
  If appropriate the option to enter a default value will be offered.

- **Question Text**
  Text that will be displayed as the question on the poll
Advanced

- **Poll**
  This can be used to move the question to another poll.

- **Order**
  Not applicable as only one question can be placed in the poll.

- **Vocabulary**
  If required a Vocabulary can be selected against the Poll.

<table>
<thead>
<tr>
<th>General</th>
<th>Advanced</th>
<th>Meta Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Question</td>
<td></td>
</tr>
<tr>
<td>Edit on Save</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Meta Data

- **Type**
  This allows you to change the Meta Data Type set against required question.

- **Edit on Save**
  Clicking on the checkbox enables you to edit the Meta Form associated with the Meta type selected.

Notes
Adding an Answer

To add an answer click onto required poll and select Explore Form, in the Form Explorer click onto poll name and select Add Answer this will display the Add New Answer form in the right hand pane. The following tabs are available; General, Advanced and Meta Data.

General

- **Name Tag**
  Used for internal reference when exploring the poll in the form manager only.

- **Default Answer**
  The answer that will be shown by default.

- **Answer Text**
  Text that will be displayed as the answer on the poll.

- **Save and Add another**
  Selecting this button will allow the user to add more than one answer.

Advanced

- **Select Question**
  Only one question will be available here

- **Order**
  Order relative to other answers in the same poll.
Meta Data

- **Type**
  This allows you to change the Meta Data Type set against required question.

- **Edit on Save**
  Clicking on the checkbox enables you to edit the Meta Form associated with the Meta type selected.

Viewing the Poll Results

When a Poll is initiated a tag is created in the Tag Library called Poll Results which can either be placed onto the same section or page as the poll or placed onto a separate page.

Viewing Responses for Polls and Forms

The originator will be notified by email when a form or poll has been completed and what the responses are. Responses can also be viewed in the **Response Manager**, to access this click onto the required form or poll, hover mouse over **View** and select the **Responses** option. Responses can be viewed individually, all at once or downloaded to a Comma Separated Value (CSV) file.

- **Viewing responses individually**
  - In the **Response Manager** click onto the required response and select **View Response**.
  - The **Form Response** form will be displayed in the right hand pane, the following details will be displayed
    - **Response Details**
      The respondents name and date and time of completion will be displayed here.
      **Note**: If Anonymous Responses in the advanced tab have been initiated then the name will not be displayed.
    - **Response Answers**
      Completed answers will be displayed here.

- **Viewing all responses**
  - In the **Response Manager** click onto the Response name at the top of the tree and select **View All Responses**.
  - In the right hand pane all responses will be displayed.

- **Downloading responses to a CSV file**
  - In the **Response Manager** click onto the Response name at the top of the tree and select **Download To CSV File**.
  - In the right hand pane click onto the **Export Now** button, click onto the **Click here to download** link to launch Excel and view the file.
Exercise: Forms and Polls

Forms
- Create a form `myname_registration`:
  - Store answers on the database
  - Redirect to the `myname_thankyou` page
- Add questions to the form:
  - forename, surname and email address (small text, mandatory)
  - date of birth (date) and specify a range
  - Occupation (drop list)
  - How did you hear about the site (large textbox)
  - Add any other fields you wish
- Create a page `myname_register` and place the form on it
  - Fill out the form twice, view the results in the Form Manager

Polls
- Create a poll `myname_members`:
  - Redirect to the `myname_thankyou` page
  - In the description box type: ‘membership benefit’
- Add a question to the poll:
  - Name Tag: `Membership Benefit`
  - Question Text: `What is the best membership benefit?`
  - Type: `Radio Buttons`
- Add following answers to the Poll:
  - Magazine
  - Travel Subsidiary
  - Holiday Discounts
  - Food and Drink Vouchers
- Create a page `myname_members_poll` and place the poll and results on it
  - Complete the poll three times observing each time what is happening to the results.
Lesson Eighteen - Menu Management

The Menu Manager gives the ability to create and manage Menus that can be used in Javascript Popup, Tiered or custom navigation systems. Where the menu appears on the page is determined for the most part by the coding in the template, where a tag or ASP function call is placed at the point the menu code is to be inserted. Menus can be placed in a Menu Library providing you have access authority otherwise all menus will be placed into the default library.

Each Menu listed in the manager represents a ‘page’ of links:

Menus can only be added at the top level. Submenus must first be created at the top level then assigned to a menu item in another menu, menu items can either be links of any type or a submenu:

This assignment of submenus allows the creation of hierarchical navigation structures:

When creating new menus there are a large number of fields to complete, for the most part these control the appearance of the Popup Menus, if Tiered Menus are being created most of these fields are obsolete as the appearance is controlled from stylesheets and will be hidden from view.
Creating a Menu

To create a new menu click on the Menu Manager at the top of the tree view, choosing Add Menu will display the Add New Menu form in the right hand pane. Initially the following tabs are available; General and Advanced.

Add New Menu Form

General

- **Name**
  This is used for internal reference in the treeview and when creating a submenu. If Javascript Menus are being used and this is a top level menu, the name will be used in the template and should not be changed.

- **Type**
  Either Tiered or Popup. Selecting Popup will display the Pop Up tab.

- **Default Link**
  This is the link that the menu will visit if the menu launcher is clicked. In Tiered Menus it is important that this link is one of the menu items.

Advanced

- **Library**
  The Library is used to store the Menu in an available library.
Adding Menu Items

To add a new menu item click onto the menu to update in the Menu Manager then select Explore Options. In the Menu Explorer click onto the menu name at the top of the tree view, choosing the Add Menu item will display the Menu Item Properties. The Add New Menu Items form will be displayed in the right hand pane. The following tabs are available; General and Advanced.

### General

1. **Menu Properties**
   a. **Name**
      - Used for reference in Activedition only.
   b. **Title**
      - The caption for the Menu Item as seen on the site
   c. **Link Type**
      - **Link**
        - Choose this to use a link from the Link Library for this item.
      - **Submenu**
        - Choose this to use an existing Sub Menu for this item.

### Action

The options available in this section will change dependant on the chosen item Type, they also allow you to choose the appropriate link or submenu to use for this menu item.

### Context Synchronisation

Allows you to select menu items so that they remain visible in the tiered menu when navigating to a linked page.
Advanced

<table>
<thead>
<tr>
<th>General</th>
<th>Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td></td>
</tr>
<tr>
<td>Order ¹</td>
<td>10</td>
</tr>
<tr>
<td>Querystring</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td></td>
</tr>
</tbody>
</table>

- **Order**
  The order relative to other Menu Items.

- **Query String**
  This field allows a value to be placed at the end of the menu link, particularly useful if the link is pointing to a custom page which has an item on it that is equal to the set value and the item is required to be displayed.

Using Context Synchronisation

Context Synchronisation allows you to select menu items so that they remain visible in the tiered menu when navigating to a page which is not on any menu.

For example selecting the ‘Core Services’ link on the C(2) site menu will display associated items to that menu as shown in Figure 1.

![Figure 1](#)

Notice in Figure 2 that when an associated item within the menu list (for example ‘Bespoke Software’) is selected the ‘Core Service’ menu remains visible this is because the ‘Bespoke Software’ menu item is part of the ‘Core Service’ menu.
Figure 2

There are links on the ‘Bespoke Software’ page to internal pages within the site, selecting anyone of these, in this case ‘NCR RSB Case Study’ will open this page but the ‘Bespoke Software’ menu item is no longer visible as shown in Figure 3.

Figure 3

The reason for this is because the ‘NCR RSB Case Study’ page is not on a menu. In order to retain the visibility of the ‘Bespoke Software’ menu item when the ‘NCR RSB Case Study’ link is selected the ‘Bespoke Software’ menu item in this case needs to be synchronised with the area that the ‘NCR RSB Case Study’ page belongs to using Context Synchronisation.
Process

In order to apply Context Synchronisation to a non-menu linked page, in this case the ‘NCR RSB Case Study’ page, carry out the following process:

1. Open Menu Manager in the Libraries section of the Main Explorer bar.

2. Select the menu that the required menu item (‘Bespoke Software’) belongs to, in this case ‘Core Services’ and select Explore Menu Options.

3. Click onto the required menu item (‘Bespoke Software’) and select Properties.

4. In the Context Synchronisation area of Menu Item Properties select the area that you want this menu item to be synchronised to, in the case above it would have been the ‘Private Sector’ area. (Note that you can select more than one area by holding the Ctrl key to select multiple areas).
5. Once selection is complete click onto Save.

6. Republish the root menu.

7. Click onto the Live Link to check that Synchronisation is working. You can see the difference that Context Synchronisation has made within the tiered menu when clicking onto the ‘NCR RSB Case Study’ link from the ‘Bespoke Software’ page by comparing Figure 3 with Figure 4.

![Figure 4](image-url)
Using Tiered Menus

If the supplied Activedition Tiered Menus are being used then one menu will act as the ‘root’ menu for the navigation. This contains all the submenus whose links appear when the top level Menu Item Title is clicked.

This menu is used in an ASP function in the template code at the point where navigation is to be inserted.

The look and feel of this kind of navigation is controlled through stylesheets rather than the menu manager.

Publishing Menus

It is essential to publish the menu once changes have been made to it; publishing allows the changes to be seen on the published page. Best working practise is to publish the parent menu this action will ensure that all changes made to sub menus will be visible on the published page.

Notes
Exercise: Menus

1. Add a new Menu myname_menu
2. Set the Type as Tiered
3. Add a internal, external, and email links to the menu
4. Add a submenu to the menu
5. Add myname_menu as the submenu of an existing menu, or add it to a template.
6. Publish myname_menu
7. View and use the menu

Notes
Section Five - Review

Lesson Summary

In this section you learnt:

1. How to create and use Forms and Polls by:
   - Adding a Form
   - Form Properties
   - Question Properties
   - Viewing Form Results
   - Adding a Poll
   - Adding a Poll Question
   - Adding a Poll Answer
   - Viewing Poll Results

2. How to use the Menu Manager to create and maintain Menus.

3. That Menus can only be added at the top level. Submenus must be first created at the top level then assigned to a menu item in another menu.

4. The following functions of Menu Manager:
   - Adding a Menu
   - Menu Properties
   - Adding Menu Items
   - Menu Item Properties
   - Using Tiered Menus
   - Context Synchronisation
Section Six - Reports

Aims and Learning Objectives

Only one report is available to the Content Contributor, the Workflow Status report. In this section you will learn about the various functions of the Workflow Status report. After this section you will have learnt the following.

- How to view a page in draft and published mode.
- How to compare versions.
- How to publish and reject pages from the report.
- Track changes made to a page.
Lesson Nineteen – Workflow Status report

It is possible for any user or group of users to be notified when the whole site, one or more areas, or one or more specific pages (in a single area) status changes to any one of the statuses present in the workflow (i.e. Draft, Awaiting Publishing, Published).

Publishers with editorial control are informed when a page is ready for their approval and publishing, managers or other staff can also be informed when content on the live site has been updated.

Reviewing and approving Web Pages when notified

The reviewer will be notified when a page is submitted for publishing; notification will take place in the Task Manager in the Main screen of Activedition and as an email. In both cases a link to the Workflow Status Report will be available.

Selecting this link will navigate the reviewer to the Workflow Status report for that page where the following tasks are available:

View Page

This task will only be available if the page has been previously published. Two options are available in the View Page task:

- **Draft**: Selecting the Draft link will display the draft version of the page; this version is the page that has recently been changed.

- **Published**: Selecting the Published link will display the published version of the page; this version is the page that is currently on the live site.
Compare

This task will be available if the page has been previously published. Selecting the Compare Versions link will navigate the reviewer to the Live-Draft Comparison screen.

Three options are available in the top left hand corner of the Comparison screen:

1. **View Changes**: Selecting this option will display the Live-Draft Changes screen where all tracked changes are displayed.

2. **Publish**: Selecting this option will publish the page.

3. **Reject with Comments**: Selecting this option will revert the page back to draft and send a message by the reviewer to the page originator.

**Workflow**

There are two options available within the Workflow task:

1. **Move To Draft**: Selecting this link will change the status of the page from Awaiting Publishing (A) to Draft (D).

2. **View Workflow**: This option will only be available if the Configurable Workflow module has been purchased. Selecting this link will display a graphical workflow indicating at what stage the page is at in the workflow.
Publishing Options

There are three options available:

1. **Reject**: Selecting this option will change the status of the page from Awaiting Publishing (A) to Draft (D).

2. **Reject with Comments**: Selecting this option will revert the page back to draft and send a message by the reviewer to the page originator.

3. **Publish**: Selecting this option will publish the page.
Section Six - Review

Lesson Summary

In this section you learnt how to use the following features of the Workflow Status Report:

- How to view a page in draft and published mode.
- How to compare versions.
- How to publish and reject pages from the report.
- Track changes made to a page.
Appendix A - Keyboard Shortcuts

Windows system key combinations
- F1: Help
- CTRL+ESC: Open Start menu
- ALT+TAB: Switch between open programs
- ALT+F4: Quit program
- SHIFT+DELETE: Delete item permanently

Windows program key combinations
- CTRL+C: Copy
- CTRL+X: Cut
- CTRL+V: Paste
- CTRL+Z: Undo
- CTRL+B: Bold
- CTRL+U: Underline
- CTRL+I: Italic

Mouse click/keyboard modifier combinations for shell objects
- SHIFT+right click: Displays a shortcut menu containing alternative commands
- SHIFT+double click: Runs the alternate default command (the second item on the menu)
- ALT+double click: Displays properties
- SHIFT+DELETE: Deletes an item immediately without placing it in the Recycle Bin

General keyboard-only commands
- F1: Starts Windows Help
- F10: Activates menu bar options
- SHIFT+F10 Opens a shortcut menu for the selected item (this is the same as right-clicking an object
- CTRL+ESC: Opens the Start menu (use the ARROW keys to select an item)
- CTRL+ESC or ESC: Selects the Start button (press TAB to select the taskbar, or press SHIFT+F10 for a context menu)
- ALT+DOWN ARROW: Opens a drop-down list box
- ALT+TAB: Switch to another running program (hold down the ALT key and then press the TAB key to view the task-switching window)
- SHIFT: Press and hold down the SHIFT key while you insert a CD-ROM to bypass the automatic-run feature
- ALT+SPACE: Displays the main window's System menu (from the System menu, you can restore, move, resize, minimize, maximize, or close the window)
- ALT+ (ALT+hyphen): Displays the Multiple Document Interface (MDI) child window's System menu (from the MDI child window's System menu, you can restore, move, resize, minimize, maximize, or close the child window)
- CTRL+TAB: Switch to the next child window of a Multiple Document Interface (MDI) program
- ALT+underlined letter in menu: Opens the menu
- ALT+F4: Closes the current window
- CTRL+F4: Closes the current Multiple Document Interface (MDI) window

Copyright 2009
• ALT+F6: Switch between multiple windows in the same program (for example, when the Notepad Find dialog box is displayed, ALT+F6 switches between the Find dialog box and the main Notepad window)

Shell objects and general folder/Windows Explorer shortcuts
For a selected object:
• F2: Rename object
• F3: Find all files
• CTRL+X: Cut
• CTRL+C: Copy
• CTRL+V: Paste
• SHIFT+DELETE: Delete selection immediately, without moving the item to the Recycle Bin
• ALT+ENTER: Open the properties for the selected object

To copy a file
Press and hold down the CTRL key while you drag the file to another folder.

To create a shortcut
Press and hold down CTRL+SHIFT while you drag a file to the desktop or a folder.

General folder/shortcut control
• F4: Selects the Go To A Different Folder box and moves down the entries in the box (if the toolbar is active in Windows Explorer)
• F5: Refreshes the current window.
• F6: Moves among panes in Windows Explorer
• CTRL+G: Opens the Go To Folder tool (in Windows 95 Windows Explorer only)
• CTRL+Z: Undo the last command
• CTRL+A: Select all the items in the current window
• BACKSPACE: Switch to the parent folder
• SHIFT+click+Close button: For folders, close the current folder plus all parent folders

Windows Explorer tree control
• Numeric Keypad *: Expands everything under the current selection
• Numeric Keypad +: Expands the current selection
• Numeric Keypad -: Collapses the current selection.
• RIGHT ARROW: Expands the current selection if it is not expanded, otherwise goes to the first child
• LEFT ARROW: Collapses the current selection if it is expanded, otherwise goes to the parent

Properties control
• CTRL+TAB/CTRL+SHIFT+TAB: Move through the property tabs

Accessibility shortcuts
• Press SHIFT five times: Toggles StickyKeys on and off
• Press down and hold the right SHIFT key for eight seconds: Toggles FilterKeys on and off
• Press down and hold the NUM LOCK key for five seconds: Toggles ToggleKeys on and off
• Left ALT+left SHIFT+NUM LOCK: Toggles MouseKeys on and off
• Left ALT+left SHIFT+PRINT SCREEN: Toggles high contrast on and off
Microsoft Natural Keyboard keys

- Windows Logo: **Start** menu
- Windows Logo+R: **Run** dialog box
- Windows Logo+M: Minimize all
- SHIFT+Windows Logo+M: Undo minimize all
- Windows Logo+F1: **Help**
- Windows Logo+E: **Windows Explorer**
- Windows Logo+F: Find files or folders
- Windows Logo+D: Minimizes all open windows and displays the desktop
- CTRL+Windows Logo+F: Find computer
- CTRL+Windows Logo+TAB: Moves focus from Start, to the Quick Launch toolbar, to the system tray (use RIGHT ARROW or LEFT ARROW to move focus to items on the Quick Launch toolbar and the system tray)
- Windows Logo+TAB: Cycle through taskbar buttons
- Windows Logo+Break: **System Properties** dialog box
- Application key: Displays a shortcut menu for the selected item

Microsoft Natural Keyboard with IntelliType software installed

- Windows Logo+L: Log off Windows
- Windows Logo+P: Starts Print Manager
- Windows Logo+C: Opens Control Panel
- Windows Logo+V: Starts Clipboard
- Windows Logo+K: Opens Keyboard Properties dialog box
- Windows Logo+I: Opens Mouse Properties dialog box
- Windows Logo+A: Starts Accessibility Options (if installed)
- Windows Logo+SPACEBAR: Displays the list of Microsoft IntelliType shortcut keys
- Windows Logo+S: Toggles CAPS LOCK on and off

Dialog box keyboard commands

- TAB: Move to the next control in the dialog box
- SHIFT+TAB: Move to the previous control in the dialog box
- SPACEBAR: If the current control is a button, this clicks the button. If the current control is a check box, this toggles the check box. If the current control is an option, this selects the option.
- ENTER: Equivalent to clicking the selected button (the button with the outline)
- ESC: Equivalent to clicking the Cancel button
- ALT+underlined letter in dialog box item: Move to the corresponding item
Appendix B - Hints and Tips

Preparing the Browser

- Make Activedition a trusted site.

- Amend Custom Level.
  - Enable Initialize and script ActiveX controls not marked as safe for scripting (For Office Upload)
If using IE7 disable the Phishing Filter

Disable the Pop-up Blocker

Pointing to the wrong DSN

- The file Configapplication.asp points to a default DSN, USERID and PSWD which is followed by a list of DSN’s for multiple sites or one DSN for a single site.

- If the DSN’s are not included or marked up incorrectly then Activedition may be accessing the wrong database.

- To check what Database Activedition is using hover mouse over the padlock icon in the login screen.
Navigating in Activedition

- Tool Bar.
  - Selecting group name will reveal group items

- Windows Drop List
  - All open windows with Activedition will be displayed
  - Find Page

- Selecting Find Page allows the user to search for a page using:
  - Names
  - Headings
  - Number
  - Titles
  - Sections
Time Out

• Normally set to 20 minutes.
  • Can be changed in the Internet Information Services application (IIS)
    Not recommended as increasing the timeout decreases security and can cause
    a memory drain.

• There is a 10 minute warning; timeout is reset to 20 minutes after initiating the
  following actions.

  • Refresh
  • Save
  • Publish
  • Open

In Context Help

• Structured as concepts followed by process.

• Updated when:
  – New version launch
  – Modification - By patch release
  – New item added - By patch release
**Activedition News Page**

- The Activedition News Page allows C2 Software to communicate news that will be of benefit to Activedition users.

- Currently this page is training orientated and is amended periodically.

- By default this page is not displayed.

- To view the Activedition News Page.
  - Open the System Group and Select Options
  - In the General tab click onto the Show Activedition News check box

**Logging Correctly**

- In V4 there is a script that will log out users who close down Activedition incorrectly.

- If user is timed out then message will be displayed on logging in that user session is active.

**Area User authorisations**

- User authority can be managed at area level.
  - Right click onto area
  - Hover mouse over Tasks
  - Select User Authorisations

- In the Authorise Users screen users can be added to do the following actions in an area:
  - Delete
  - Update
  - Publish
Locked Users

- Site Users are locked out from the delivery end if they incorrectly log in to a secure area 3 times.

- Their user session is unlocked in the User Manager by selecting Tasks/Unlock Account.

- To amend the log in attempts amend the following line in ConfigApplication.asp (V4 or below) or Web.config (V4.1 and above)
  - For maximum 5 entries
    USERApplication_FailedLoginMaxTries = “5”
  - For disabling the lock out feature
    USERApplication_FailedLoginMaxTries = “-1”

Note: The Global.asa file will need to be reset if any changes are made
Virtual Areas

- Virtual Areas are used to set up campaign folders such as www.400training/events2007 rather than: http://400training.training/NewsandEvents/LatestNews/Events2007.asp

- They are created by right mouse clicking onto the Site Manager root node and selecting Add Virtual area.

- A simple form is displayed where the required name of the Virtual area is entered followed by selecting the published page required for the Virtual Area.

  ![Add Virtual Area](image)

- Once Virtual Area is saved it needs to be published.

Office Upload

- Office upload can be applied to Word and Excel documents:
  - Currently we offer upload support to Word 97 to 2007 and Excel 97 to 2003
  - Excel 2007 document upload is not yet supported

- Spurious characters in uploaded Word documents.
  - Happens when a site is set to UTF8 and Word is set to saving document as Western European (Windows)
  - **Procedure**
    - In the Area Manager right mouse click onto the Area Manager name node, hover mouse over Add and select Virtual Area.
    - Word 2007: Word Options/Advanced/Web Options/Encoding
    - Word 2003: Tools/Options/General/Web Options/Encoding
Live/Draft Page comparison

- Providing the page has been previously published the draft (amended) version can be compared with the published page in the Page Manager or Page explorer.
  - Right Click onto required page
  - Hover mouse over View
  - Select Live-Draft Comparison
Email Page to user

- If you do not have PDF publisher you can still send the completed page to an existing user of Activedition by:
  - Right clicking onto required page in the Page Manager
  - Hover mouse over Tasks
  - Select Email Page to User

- If subscribed to eMessenger you can send the published page to any email list or group in Activedition by:
  - Right clicking onto required page in the Page Manager
  - Hover mouse over Tasks
  - Select Email Page to User (eMessenger)

- The date and time for the email can be scheduled. If this is left blank then the email will be sent immediately.
Statistics from the Page Manager

- It is recommended that for effective Web Statistics Google analytics is used in conjunction with External Link Logging and Search Term Logging.

- In System Options:
  - Disable Page Statistics
  - Enable External Link Logging
  - Enable Search Term logging

- Add the following code into site templates

```html
<script src="http://www.google-analytics.com/urchin.js" type="text/javascript">
</script>
<script type="text/javascript">
  _uacct = "UA-380497-2";
  UrchinTracker();
</script>
```
Displaying Section placements

• If the Autoadd switch is not added to an <aesection> or <aesections> tag in the template then section placements will not be displayed in the Page Explorer bar and Page editor.

  – An <aesection> tag can only render a single section, the following line will display a single section placement
    • <aesection autoadd="1"/>

  – The following line will display 2 single section placements
    • <aesection autoadd="1"/>
    • <aesection autoadd="1"/>

  – The following line will display 2 section placements with an option to add more in the Page Explorer when required
    • <aesections autoadd="2"/>

Customised Styling

• Customised styling can be used by placing sub classes between /*begin Aestyle*/ and /*end Aestyle*/ tags in the template.

/* begin ASTYLE*/

.cellBackgroundColorBlue{
  background-color: blue;
  FONT-SIZE: 11px;
  COLOR: white;
}

.cellBackgroundColorPurple{
  background-color: #A00FF;
  FONT-SIZE: 10px;
  COLOR: white;
  font-weight: bold;
  font-family: Arial
}

.image{
  padding-right:5px;
}

/* end ASTYLE*/

• These can then be used in the Custom Style drop list in the Page Editor.

• To enforce a sub class used from the Custom Style drop list the switch! Important is used with the required sub class.

  .image{
    padding-right:5px; !Important
  }
Version History

- **Section**
  - Triggered by Save
  - Default 5 Versions (set in System Options)
  - Use this Version/Rollback

- **File**
  - Triggered by Upload replacements
  - Use this Version/Rollback

- **Page**
  - Triggered by Publish
  - Versions are reset by Activedition on a date basis
  - Does not have Use this Version/Rollback

Dropdown lists using Vocabularies

- Vocabularies are user-defined lists of values centrally held in the content manager that can be used in Form drop lists or radio buttons.

- Setting up Vocabularies:
  - They are set up in the Content Manager by right clicking on Vocabularies and selecting Add Vocabulary, once created Values are then added to the Vocabulary.

- Using Vocabularies in Droplists and Radio Buttons:
  - In the required form select properties of either a drop list or radio button type question and open the Advanced tab
  - In the Vocabulary drop list select require vocabulary then click onto the adjacent check box to select.
Embedding Tags in Newsgroups

- Initiated in System Options/Website.
  - Checkbox: Allow links in newsgroups

- Using the following tags:
  - [email]mike.furlong@c2software.com[/email]
  - [b]This is bold text[/b]
  - [i]This is text in italics[/i]
  - [u]This text is underlined[/u]

Using the Meta Data Filter

- The Advanced Meta Data Filter allows user to write out a data query string to search for users that have had a Meta data attribute set against them on creation.
- To return a list of all users who live in Dundee or Perth:
  - [UserTown EQUALS ‘Dundee’] OR [UserTown EQUALS ‘Perth’]
- Following filters are available:
  - EQUALS: Equals to
  - NOT EQUALS: Not equal to
  - GTOET: Greater than or equals to
  - LTOET: Lesser than or equals to
  - GT: Greater than
  - LT: Lesser than

Note: The logical operands OR & AND can be used to join Meta Data filters.
Appendix C - Glossary

A

ActiveX  A set of technologies that allows software components to interact with one another in a net-worked environment, regardless of the language in which the components were created.

ActiveX control  A reusable software component that can be used to incorporate ActiveX technology.

B

Browser  A Web access program that can request HTML documents from Web servers and render such documents on a user’s display device.

Bookmark  A reference to a site held within the Browser in a list of URLs.

D

Document  The basic unit of HTML information, a document refers to the entire contents of any single HTML file. Because this concept doesn’t always correspond to normal notions of a document, we refer to what could formally be called HTML documents more or less interchangeably with Web pages, which is how such documents are rendered by browsers for display.

Double-Click  To rapidly press and release a mouse button twice without moving the mouse. Double-clicking carries out an action, such as starting a program.

Download  To transfer a file from a server to a user across a network or the internet.

Drag  To move an item on the screen by selecting the item and then pressing and holding down the mouse button while moving the mouse.

E

e-mail  An abbreviation for electronic mail, e-mail is the preferred method for exchanging information between users on the internet (and other networked systems).

External reference  A resource that is stored somewhere other than where a Web document or program is located.

F

File  A collection of information that has been given a name and is stored on a disk. This information can be a document or a program.

Forms  In HTML, forms are built on special markup that enables browsers to solicit data from users and then deliver that data to specially designated input-handling programs on a Web server. Briefly, forms provide a mechanism to enable users to interact with servers on the Web.

G

GIF  (Graphics Information File)  GIF is one of a set of commonly used graphics formats within Web documents. GIF is commonly used because of its compressed format and compact nature.

Graphical User Interface  See GUI.

Graphics  in HTML documents, graphics are files that belong to one of a restricted family of types (usually GIF or JPEG) that are referenced via URLs for inline display on Web pages.

GUI  (Graphical User Interface, pronounced gooey)  GUIs are what make graphical Web
browsers possible; they create visually oriented Interface that makes user’s interaction with computerised information easier.

**H**

**HTML** (Hyper Text Markup Language) The language used to create Web pages. Not quite a programming language, HTML, nevertheless provides a rich lexicon and syntax for designing and creating useful hypertext documents for the Web.

**http** or **HTTP** (Hypertext Transfer Protocol) The Internet protocol used to manage communication between Web clients (browsers) and servers.

**Hyperlink** A shorthand term for hypertext link. See also **hypertext link**.

**Hypertext** A method of organising text, graphics, and other data for computer use that lets individual data elements point to one another, hypertext is a nonlinear method of organising information (especially text).

**Hypertext link** In HTML, a hypertext link is defined by special markup that creates a user selectable document element that, when selected, can change the user’s focus from one document (or part of a document) to another.

**J**

**JPEG** or **JPG** (Joint Photographic Experts’ Group) An Industry association that defined a particularly compressible format for image storage that is designed for dealing with complex colour still images (like photographs). Files stored in this format usually take the extension JPEG (except on DOS or Windows machines, which use the three-character JPG equivalent). Today, JPEG is emerging as the graphics format standard of choice for use on the **WWW**.

**L**

**LDAP** See **Lightweight Directory Access Protocol** (LDAP)


**Link** For HTML, a link is a pointer in one part of a document that can transport users to another part of the same document or to another document entirely. This capability puts the hyper into hypertext.

**Libraries** These are repositories that hold resources such as multimedia or forms.

**M**

**Metadata** Information about the properties of data, such as the type of data in a column (numeric, text and so on) or the length of a column. Information about structure of data. Information that specifies the design of objects such as cubes or dimensions.
**Metatags** This is a special HTML tag that is used to store information about a Web page but is not displayed in a Web browser. For example, meta tags provide information such as what application was used to create the page, a description of the page, and keywords that are relevant to the page. Many search engines use the information stored in Meta tags when they index Web pages.

**Multimedia** A method of combining elements such as text, sound, graphics and full-motion or animated video within a single compound computer document.

**Newsgroup** An electronic discussion group or bulletin board that is devoted to discussion of a specific topic. A newsgroup consists of postings, which are messages that have been addressed to the newsgroup rather than a specific individual.

**Pages** The generic term for the HTML documents that Web users view on their browsers.

**PDF** (Portable Document Format) The name of the document format for Acrobat from Adobe Systems, Inc. PDF is also used as the file extension for files in this particular format.

**Publish** Publishing Pages or Areas will make them available to the live site.

**Server** In general, a computer that provides shared resources to network users.

**Section** An area that contains textual content or items placed from the various resource libraries such as the Multimedia, Link and Tag libraries. Where Sections appear on a page is determined by the template.

**Section Library** Allows sections to be managed on a per library basis, any changes made to a section held in the section library will affect all placements of that section throughout the site.

**Site** This is a container for Site Areas, when logged into Activeedition you can only manage one Site.

**Site Areas** These can contain other Site Areas, allowing hierarchical structures to be built similar to Directories on a PC. Site Areas can also contain Pages.

**SSL** (Secure Sockets Library) A Web commerce programming library, intended to help programmers to easily add secure transactions across the Web.

**Style Sheet** The Style sheet defines the fonts, sizes and colours used, substantially enforcing brand consistency across the site.

**Tag** A small snippet of HTML Code

**Template** Activeedition templates are constructed in standard HTML like any other webpage. With specialist Active edition tags embedded in the code to control the location of content and other items on the pages.
**URL** (Uniform Resource Locator) The primary naming scheme used to identify Web resources, URLs define the protocols to be used, the domain name of the Web server where a resource resides, the port address to be used for communication and the directory path to access a named Web file or resource.

**W**

**Web**  Shorthand for the World Wide Web (or W3) it can also refer to a related, interlinked set of HTML documents.

**Web Server** A computer that is maintained by a system administrator or Internet Service Provider (ISP) and that responds to requests from a user’s browser.

**Web Site** An addressed location, usually on the Internet, that provides access to the set of Web Pages corresponding to the URL for a given site; thus a Web Site consists of a Web Server and a named collection of Web documents, both accessible through a single URL.

**Workflow** Used in conjunction with publishing. If Workflow is enabled the option of *Awaiting Publishing* is added as another status of publishing. In this case pages must be submitted for publishing prior to being published. This allows specific users to have editorial control over the content that is set live on the website.